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Preface

Thank you for purchasing our product.
This Operator’s Manual describes how to use the fax functions and perform maintenance, etc.
Read this manual before using the functions.

How to read this manual

 Symbols in this manual

In this manual, some important items are described with the symbols shown below. Be sure to read these items 
before using this equipment.

 Description of original/paper direction

Paper or originals of A4, B5 or LT size can be placed either in a portrait direction or in a landscape direction. In this 
manual, “-R” is added to this paper size when this size of paper or original is placed in a landscape direction.

Example: A4 size original on the original glass

Paper or originals of A3, B4, LD or LG can only be placed in a landscape direction, therefore “-R” is not added to these 
sizes.
For the e-STUDIO400AC Series, paper or originals can only be placed in a landscape direction, therefore “-R” is not 
added to these sizes.

Indicates a potentially hazardous situation which, if not avoided, could result in death, serious 
injury, or serious damage, or fire in the equipment or surrounding objects.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or 
moderate injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.

Placed in a portrait direction: A4 Placed in a landscape direction: A4-R
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 Model and series names in this manual

In this manual, each model name is replaced with the series name as shown below.

 Optional equipment

For the available options, refer to the Quick Start Guide.

 Screens in this manual

 In this manual, Windows10 is taken for explanation purposes to describe the screens and operation procedures in 
Windows.

 The details on the screens may differ depending on your model and how the equipment is used, such as the status 
of the installed options, the OS version and the applications.

 The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the 
display or the order of buttons in the illustrations may differ from that of your equipment.

 Abbreviations in this manual

In this manual, “Dual Scan Document Feeder”(DSDF) and “Reversing Automatic Document Feeder”(RADF) are 
collectively referred to as “Automatic Document Feeder”(ADF). In this manual, “Dual Scan Document Feeder” is 
referred to as “DSDF” and “Reversing Automatic Document Feeder” as “RADF”.

 Trademarks

For trademarks, refer to the Safety Information.

 Accessories
Accessories provided for GD-1370

 Modular cable: 1
 Operator’s manual: 1

Model name Series name

e-STUDIO2010AC/2510AC e-STUDIO5015AC Series

e-STUDIO2515AC/3015AC/3515AC/4515AC/5015AC

e-STUDIO2018A/2518A/3018A/3518A/4518A/5018A e-STUDIO5018A Series

e-STUDIO5516AC/6516AC/7516AC e-STUDIO7516AC Series

e-STUDIO5518A/6518A/7518A/8518A e-STUDIO8518A Series

e-STUDIO330AC/400AC e-STUDIO400AC Series
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Notice to Users

For U.S.A. only

WARNING FCC Notice: Part 15 and Part 18
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 
(e-STUDIO2010AC/2510AC, e-STUDIO2018A/2518A/3018A/3518A/4518A/5018A, e-STUDIO330AC/400AC), Part 15 and 
18 (e-STUDIO2515AC/3015AC/3515AC/4515AC/5015AC, e-STUDIO5516AC/6516AC/7516AC, e-STUDIO5518A/6518A/
7518A/8518A) of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with this guide, may cause harmful 
interference to radio communications. Operation of this terminal in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his/her own expense.

Warning: Changes or modification made to this equipment, not expressly approved by Toshiba TEC or parties 
authorized by Toshiba TEC could void the user’s authority to operate the equipment.

WARNING FCC Notice: Part 68
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On the rear cover 
of this equipment is a label that contains, among other information, a product identifier in the format US: 
AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

This device is equipped with a USOC RJ11C connector.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the 
applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is 
provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See 
installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a 
telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum 
of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as 
determined by the total RENs, contact the local telephone company. For products approved after July 23, 2001, the 
REN for this product is part of the product identifier that has the format US: AAAEQ##TXXXX. The digits represented by 
## are the REN without a decimal point (e.g., 03 is a REN of 0.3).
For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that 
temporary discontinuance of service may be required. But if advance notice isn’t practical, the telephone company 
will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if 
you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the 
operation of the equipment. If this happens the telephone company will provide advance notice in order for you to 
make necessary modifications to maintain uninterrupted service.

If trouble is experienced with this equipment, for repair or warranty information, please contact Toshiba America 
Business Solutions Electronic Imaging Division at 1-800-468-6744. If the equipment is causing harm to the telephone 
network, the telephone company may request that you disconnect the equipment until the problem is resolved.

Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service 
commission or corporation commission for information.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device, including Fax machines, to send any message unless such message clearly contains in a margin at 
the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an 
identification of the business or other entity, or other individual sending the message and the telephone number of 
the sending machine or such business, other entity, or individual. (The telephone number provided may not be a 900 
number or any other number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your Fax machine, you should complete the following steps: complete the 
setup procedures listed for station ID number and name. Refer to the MFP Management Guide.
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CAUTION — To reduce the risk of fire, use only No.26 AWG or larger telecommunication line cord.

IMPORTANT SAFETY INSTRUCTION
When using your telephone equipment, avoid using a telephone (other than a cordless type) during an electrical 
storm. There may be a remote risk of an electric shock from lightning.
SAVE THIS INSTRUCTION

Toshiba America Business Solutions, Inc.
25530 Commercentre Drive, Lake Forest, CA 92630

For Canada only

NOTICE: This product meets the applicable Innovation, Science and Economic Development Canada technical 
specifications.

The Ringer Equivalence Number of your facsimile is 0.2

NOTICE: The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be connected 
to a telephone interface. The termination of an interface may consist of any combination of devices subject only to the 
requirement that the sum of the RENs of all the devices not exceed five.

CAUTION — To reduce the risk of fire, use only No.26 AWG or larger telecommunication line cord.

This Class A digital apparatus complies with Canadian ICES-003. (CAN ICES-3(A))

AVIS: Le présent produit est conforme aux spécifications techniques applicables d’Innovation, Sciences et 
Développement économique Canada.

L’indice d’equivalence de la sonnerie de ce matériel 0.2.

AVIS: L’indice d’équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de dispositifs qui peuvent être 
raccordés à une interface téléphonique. La terminaison d’une interface peut consister en une combinaison 
quelconque de dispositifs, à la seule condition que la somme des IES de tous les dispositifs n’excède pas cinq.

ATTENTION – Pour réduire les risques d’incendie, utiliser uniquement des conducteurs de telecommunications 26 
AWG au de section superleure.

IMPORTANTE MESURE DE SÉCURITÉ
Pendant I'utilisationo de matériel téléphonique, éviter d’utiliser le téléphone (sauf s’il s’agit d’un appareil sans fil) 
pendant un orage électrique. Ceci peut présenter un risque de choc électrique causé par la foudre.
CONSERVER CETTE INSTRUCTION

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. (CAN NMB-3(A))

Toshiba Tec Canada Business Solutions Inc.
75 Tiverton Court,
Markham, Ontario, L3R 4M8
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For NEW ZEALAND only

“The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item 
complies with minimum conditions for connection to the network. It indicates no endorsement of the product by 
Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work correctly 
in all respects with another item of Telepermitted equipment of a different make or model, nor does it imply that any 
is compatible with all of Telecom’s network services.”

“This equipment is not capable, under all operating conditions, of correct operation at the higher speeds for which it 
is designated. Telecom will accept no responsibility should difficulties arise in such circumstances.”

“This equipment should not be used any circumstances which may constitute a nuisance to other Telecom 
customers.”

“Not all telephones will respond to incoming ringing when connected to the extension socket.”

“This device is equipped with pulse dialling while the Telecom standard is DTMF tone dialling. There is no guarantee 
that Telecom lines will always continue to support pulse dialling.”

“Use of pulse dialling, when this equipment is connected to the same line as other equipment, may give rise to bell 
tinkle or noise and may also cause a false answer condition. Should such problems occur, the user should NOT 
contact the Telecom Faults Service.”

“This device is intended for Stand-alone connection and not in parallel with other telephone devices.”

“The call log incorporated in this equipment does not record all answered calls. The call log, therefore may not agree 
with the Telecom account which may include calls not shown on the log.”

“If a charge for local calls is unacceptable, the ‘Dial’ button should NOT be used for local calls. Only the 7-digits of the 
local number should be dialled from your telephone. DO NOT dial the area code digit or the ‘0’ prefix.”

Toshiba (Australia) Pty Limited
58 Lunn Avenue,
Mt Wellington 1072
New Zealand.
Phone: 64-9-570 8530
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For EU only

Warning: This is a Class A product. In a domestic environment this product may cause radio interference in which 
case the user may be required to take adequate measures.

Working environment
From EMC (Electromagnetic Compatibility) point of view, the operation of this product is being restricted in 
following environments:

 Medical Environments: This product is not certified as a medical product according to the Medical Product 

Directive 93/42/EEC.

 Domestic environments (e.g. a private living room with TV / Radio sets in the nearby surrounding area) because 

this is a so called EMC class A product. In a domestic environment this product may cause radio interference in 

which case the user may be required to take adequate measures!

Any consequences resulting from the use of this product in restricted working environments are not the 
responsibility of TOSHIBA TEC.
The consequences of the use of this product in restricted working environments may be an electromagnetic 
interference with other devices or machines in the nearby surrounding area. This can result into malfunction 
including data loss / data error pertaining to this product or the other devices / machines involved in the 
electromagnetic interference.
Furthermore, for general safety reasons, the use of this product in environments with explosive atmospheres is 
not permitted.
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General Precautions

 Disclaimer notice
The following notice sets out the exclusions and limitations of liability of TOSHIBA TEC CORPORATION (including its 
employees, agents and sub-contractors) to any purchaser or user (hereafter “User”) of the e-STUDIO2010AC/2510AC, 
e-STUDIO2515AC/3015AC/3515AC/4515AC/5015AC, e-STUDIO2018A/2518A/3018A/3518A/4518A/5018A, 
e-STUDIO5516AC/6516AC/7516AC, e-STUDIO5518A/6518A/7518A/8518A, e-STUDIO330AC/400AC including its 
accessories, options and bundled software (hereafter “Product”).

1. The exclusion and limitations of liability referred to in this notice shall be effective to the fullest extent 
permissible at law. For the avoidance of doubt, nothing in this notice shall be taken to exclude or limit TOSHIBA 
TEC CORPORATION’s liability for death or personal injury caused by TOSHIBA TEC CORPORATION’s negligence or 
TOSHIBA TEC CORPORATION’s fraudulent misrepresentation.

2. All warranties, conditions and other terms implied by law are, to the fullest extent permitted by law, excluded 
and no such implied warranties are given or apply in relation to the Products.

3. TOSHIBA TEC CORPORATION shall not be liable for any loss, cost, expense, claim or damage whatsoever caused 
by any of the following:

- use of handling of the Product otherwise than in accordance with the manuals, including but not limited to the 
Operator’s Manual, User’s Guide, and/or incorrect or careless handling or use of the Product;

- any cause which prevents the Product from operating or functioning correctly which arises from or is 
attributable to either acts, omissions, events or accidents beyond the reasonable control of TOSHIBA TEC 
CORPORATION including without limitation acts of God, war, riot, civil commotion, malicious or deliberate 
damage, fire, flood, or storm, natural calamity, earthquakes, abnormal voltage or other disasters;

- additions, modifications, disassembly, transportation, or repairs by any person other than service technicians 
authorized by TOSHIBA TEC CORPORATION; or

- use of paper, supplies or parts other than those recommended by TOSHIBA TEC CORPORATION.

4. Subject to paragraph 1, TOSHIBA TEC CORPORATION shall not be liable to Customer for:

- loss of profits, loss of sales or turnover; loss of or damage to reputation; loss of production; loss of anticipated 
savings; loss of goodwill or business opportunities; loss of customers; loss of, or loss of use of, any software or 
data; loss under or in relation to any contract; or

- any special, incidental, consequential or indirect loss or damage, costs, expenses, financial loss or claims for 
consequential compensation;

whatsoever and howsoever caused which arise out of or in connection with the Product or the use of handling of the 
Product even if TOSHIBA TEC CORPORATION is advised of the possibility of such damages.
TOSHIBA TEC CORPORATION shall not be liable for any loss, cost, expense, claim or damage caused by any inability to 
use (including, but not limited to failure, malfunction, hang-up, virus infection or other problems) which arises from 
use of the Product with hardware, goods or software which TOSHIBA TEC CORPORATION has not directly or indirectly 
supplied.
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 Features and Functions
Installing the FAX unit in this equipment will make the following fax functions usable.

 Fax function
Faxes can be sent and received by using a phone line.

 Network Fax function
The Network Fax features can simplify and facilitate your office facsimile needs and enables you to send fax or 
Internet Fax digital documents directly from your computer.
Installing the highly intuitive, network N/W-Fax driver software enables you to send fax or Internet Fax digital 
documents from your computer to one or more recipients.
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1.BEFORE USING FAX

This chapter describes the basics of the FAX Unit you should learn before you start using it.

Description of Each Component.........................................................................................16
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Touch panel..........................................................................................................................................................16
Options .................................................................................................................................................................17
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0.Description of Each Component

 Control panel
For details of  the buttons on the control panel, refer to the Quick Start Guide.

 Touch panel
This section describes the fax screen on the touch panel. For details of the touch panel not covered in this document, 
refer to the Quick Start Guide.

1. Function display
The function being used is displayed.

2. Message indication area
This shows a brief description of the functions or the current status of this equipment in message form.

3. Destination indication area ( P.35)
The number of the selected recipients and their names are displayed.

4. [Clear All Dest.] button ( P.39)
This is to clear all the displayed recipients in the destination indication area.

5. Alert message indication area
Messages are shown here to inform you of various alerts such as the replacement time of toner cartridges and 
waste toner boxes, or the existence of a received Secure Receive fax job.

6. Original size setting button ( P.29)
This is to set the original size.

7. Resolution setting button ( P.30)
This is to set the resolution when scanning an original.

8. Option setting button ( P.31)
This is to set the option.

9. Date and time
The current date and time are shown here.

10. [Job Status] button ( P.44)
Use this button to view the job status or its history.
This is to view the job status or its history.

11. [Preview] button ( P.40)
This is to display a preview of a scanned image before the transmission.

12. [Send] button ( P.27)
This is to send a fax job.

13. Address indication area ( P.36)
The recipients registered in the address book are displayed. For details of the operation, refer to the MFP 
Management Guide or TopAccess Guide.

When an individual recipient is selected from the address book, confirm that the selected one is displayed on the 
recipient list on the left side of the screen.
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14. Search button ( P.36)
This is to search the recipients.

15. Favorite/index buttons

This is to refine the recipients registered in the address book. When you press , only the recipients registered 

in the favorite are displayed in the address indication area. When you press any of the index buttons, only the 
applicable recipients registered in each index are displayed in the address indication area.

16. Address book switch buttons
This is to switch the local or shared address book. These buttons are displayed only when the use of the shared 
address book is available. For details about the shared address book, refer to the TopAccess Guide.

17. Recipient selection method switch tab ( P.35)
This is to switch the selection method of the recipients.

18. On-hook transmission button ( P.42)
This is to perform on-hook transmission.

19. [?](Help) button
This is to view the explanation of each function or the buttons on the touch panel.

20. Language button
This is to switch a language.

21. Adding to Home screen button
This is to add a setting such as a job setting to the Home screen. For more instructions, refer to the Template 
Guide.

22. [Template] button
This is for the template function. For more details, refer to the Template Guide.

23. [Settings] button
This is to check currently set functions.

24. [Storage] button ( P.77)
This is for the storage function.

When this equipment is managed under the department management or user management, key in user information 
such as the department code, user name and password to display the operation screen. For details of the operation, 
refer to the Quick Start Guide.

Options
This section describes the options related to the fax function.

 FAX Unit
This unit enables the use of the fax function. Two fax units can be installed in one piece of equipment at a 
maximum. Install two fax units if you want to send/receive faxes using 2 lines.

The 2nd line for FAX Unit is not available to some models.
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0.Connecting Cables

Be sure that the power of the MFP is turned OFF before connecting the cables.

e-STUDIO5015AC Series / e-STUDIO5018A Series

e-STUDIO7516AC Series / e-STUDIO8518A Series

1
2

3

1
2

3
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e-STUDIO400AC Series

1. LINE
Connect a public network line.

2. LINE2
Connect a public network line when multiple fax units are installed.

LINE2 is not available to some models.

3. TEL
Connect an external telephone.

 Do not connect the cable for a public network line into the TEL. Otherwise, the MFP may malfunction.
 Do not connect the MFP and the external telephone to a public network line in parallel.
 Use the external telephone without an answerphone (or with the function off) to be connected with the TEL.

1

3
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This chapter describes how to send and receive a fax.
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0.Operating the Fax unit

 Placing an original

 Originals that can be sent

Operating the Fax unit, you can send a fax of the following originals.
You can place 1-sided or 2-sided originals of media types, such as plain paper, recycled paper and paper having holes 
(2, 3 or 4 holes) for filing, on the RADF (Reversing Automatic Document Feeder) or DSDF (Dual Scan Document Feeder). 
When the original glass is used, originals such as overhead transparencies, tracing paper, booklet or 3-dimensional 
objects, that cannot be placed on the ADF can be scanned, as well as plain paper.

Other than the e-STUDIO400AC Series

* You may not obtain enough image quality when an original with a paper weight of more than 157 g/m2 (41.8 lb.) is used.

For the e-STUDIO400AC Series

 Do not place any heavy objects (4 kg/9 lb. or over) on the original glass and do not press on it with force.
 If the original is any of the following sizes, it is automatically rotated and sent as described below. This function is 

not available to some models.
A4 to A4-R
A5-R to A5
B5-R to B5
LT to LT-R
ST-R to ST

 You need to select the original size by yourself when placing the following originals whose sizes cannot be detected 
correctly:

- Highly transparent originals (e.g. overhead transparencies, tracing paper)
- Totally dark originals or originals with dark borders
- Non-standard size originals (e.g. newspapers, magazines)

Location Maximum size Paper weight Original size

Original glass

Length: 297 mm 
(11.69")
Width: 432 mm 
(17.01")

- North American format:
LD, LG, LT, LT-R, ST, ST-R, COMP
A/B format:
A3, A4, A4-R, A5, A5-R, B4, B5, B5-R, 
FOLIO

ADF RADF 1-sided originals:

35 - 157 g/m2 (9.3 - 41.8 lb.)
2-sided originals:

50 - 157 g/m2 (13.3 - 41.8 lb.)

North American format:
LD, LG, LT, LT-R, ST-R, COMP
A/B format:
A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO
(ST/A5 is not available)

DSDF 1-sided originals:
35 - 209 g/m2 * (9.3 - 41.8 lb.)
2-sided originals:

50 - 209 g/m2 * (13.3 - 41.8 lb.)

Location Maximum size Paper weight Original size

Original glass
Length: 216 mm 
(8.5")
Width: 356 mm 
(14")

-
North American format:
LG, LT, ST
A/B format:
A4, A5, B5, FOLIO

DSDF 1-sided originals:

35 - 105 g/m2 (9.3 - 28 lb.)
2-sided originals:

35 - 105 g/m2 (9.3 - 28 lb.)
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 Original scanning range

The following figures show the original scanning area. Any information in the shaded area is not printed on the paper.

1. LD, LG, LT-R, ST-R, COMP, A3, A4-R, A5-R, B4, B5-R, FOLIO
2. LT, ST, A4, A5, B5
3. (For the e-STUDIO400AC Series) LT, LG, ST, A4, A5, B5, FOLIO

 Placing the original(s) on the original glass

This section describes how to set an original on the original glass.
Originals are sent in the order they are placed on the original glass.

Do not place any heavy objects (4 kg/9 lb. or over) on the original glass and do not press on it with force.
Breaking the glass could injure you.

1 Raise the original cover or ADF, and place the original with its face down.

Raise it at least 60 degrees to allow the original to be detected appropriately.
You need to set the size of the original manually to some models.

1 2 3

2 mm
(0.08")

2 mm
(0.08")

2 mm
(0.08")

2 mm
(0.08")

2 mm
(0.08")

2 mm
(0.08")

2 mm
(0.08")

4.2 mm
(0.17")

4.2 mm
(0.17")

4.2 mm
(0.17")

4.2 mm
(0.17")

2 mm
(0.08")
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2 Align the original against the left inner corner of the glass.

 Different size originals can also be sent in one transmission.

 When an original of any size other than LT/A4 is placed in the direction shown in the above left-hand figure or 
the e-STUDIO400AC Series is used, transmission to a recipient is carried out so that the pre-entered sender 
information is printed in position A in the figure.

 When an original of LT/A4 size is placed in the direction shown in the above right figure, transmission to a 
recipient is carried out so that the pre-entered sender information is printed in position B in the figure.

 The pre-entered sender information shows what is registered in the Terminal ID.
For details about the registration method of the Terminal ID, refer to the MFP Management Guide.

3 Lower the original cover or ADF slowly.

 Placing the original(s) on the ADF

This section describes how to set the original(s) on the ADF. When the originals are placed on the RADF, the uppermost 
page is the first to be scanned and sent.

1 After aligning the originals, place them with their face up and slide the guides to rest against the 
edges of the originals.

 When the DSDF (Dual Scan Document Feeder) is used:

Regardless of the paper size, originals are acceptable up to 300 sheets (35 to 80 g/m2 (9.3 to 20 lb. Bond)) or 38 
mm (1.50") in height.

 When the RADF (Reversing Automatic Document Feeder) is used:

Regardless of the paper size, originals are acceptable up to 100 sheets (35 to 80 g/m2 (9.3 to 20 lb.)) or 16 mm 
(0.62") in height.

 (For the e-STUDIO400AC Series) When the DSDF is used:
Regardless of the paper size, originals are acceptable up to 100 sheets (35 to 80 g/m2 (9.3 to 20
lb.)) or 16 mm (0.62") in height.

A B
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 2-sided originals can be set and sent.
 P.29 “Setting the transmission conditions”

 When an original of any size other than LT/A4 is placed in the direction shown in the above left-hand figure or 
the e-STUDIO400AC Series is used, transmission to a recipient is carried out so that the pre-entered sender 
information is printed in position A in the figure.

 When an original of LT/A4 size is placed in the direction shown in the above right figure, transmission to a 
recipient is carried out so that the pre-entered sender information is printed in position B in the figure.

 The pre-entered sender information shows what is registered in the Terminal ID.
For details about the registration method of the Terminal ID, refer to the MFP Management Guide.

Placing 2-sided originals

To set 2-sided originals of the LT/A4 size, change their direction depending on their bound positions as follows.

1. Right-to-left (book-type) original
2. Top-to-bottom (tablet-type) original

 For the e-STUDIO400AC Series, originals can only be placed in a landscape direction.
 When sending a 2-sided original, it is necessary to select the 2-sided setting as the transmission condition.
 P.29 “Setting the transmission conditions”

A B

1 2



2.USING THE FAX UNIT (BASIC OPERATION)

26    Operating the Fax unit

Sending different size originals

To set different width originals, adjust the side guides to the widest original size, and then align the original against 
the front side. Available combinations of the original size are as follows.

 A/B format: A3, A4, B4, B5, A4-R, FOLIO
 North American format: LD, LT, COMP, LG, LT-R

For the e-STUDIO400AC Series
Available combinations of the original size are as follows:

 A/B format: A4, FOLIO
 North American format: LG, LT

To send different width originals, you need to enable “Different Width” as a transmission condition.
 P.29 “Setting the transmission conditions”

Notes for using the ADF

Do not use the following types of original as they may cause a paper misfeed or damage to the equipment:

1. Originals that are folded or curled
2. Originals with carbon copies
3. Originals that have been taped, pasted, or cut-out
4. Originals with multiple holes punched (e.g. loose leaf paper)
5. Originals that have been clipped or stapled
6. Originals with holes or tears
7. Originals that are damp
8. Originals whose correction fluid or ink has not been dried completely
9. Overhead transparencies or tracing paper
10. Coated paper (e.g. coated with wax)
11. India paper (used for dictionaries, bibles, etc.)

1 3 42

6

11

7

9 10

5

8
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The following types of originals can be used but need extra care:

1. Originals that you cannot slide with your fingers or whose surface is specially treated
They should be fanned well before loading since they may not be able to be separated from each other at 
feeding.

2. Originals that are folded or curled
They should be smoothed out before being loaded.

 Sending a Fax
This section describes the basic procedures to send a fax. For details of in-depth operations, see the page under each 
procedure as required.
Besides the basic sending functions described in this page, there are various useful ways to send a fax. These 
procedures are described in the following pages.
 P.42 “On-hook transmission/Off-hook transmission”
 P.57 “USING THE FAX UNIT (USEFUL FUNCTIONS)”

1 Place the original(s).
Check the original size and scanning range, etc. Place the original(s) in the correct direction on the original glass 
or ADF.
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.
The fax screen is displayed. If you leave the screen unattended for the period of the auto clear setting time (45 
sec. by default), the screen returns to the default one automatically.

3 Set the original size, resolution and other necessary conditions.

Press each button to display the transmission condition setting screen. For details, see the following page.
 P.29 “Setting the transmission conditions”

1 2
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4 Specify the recipient.

There are multiple methods to specify the recipients. For details, see the following page.
 P.35 “Specifying the recipient”
To display the preview screen, press [Preview].
 P.40 “Displaying the preview before sending a fax”

5 Press [Send].

The fax is sent or reserved.

 Alternatively, you can press the [START] button on the control panel to send a fax.
 In the memory transmission mode, the original is scanned into memory. Once a connection has been made, 

this equipment automatically starts sending the scanned document. In the direct transmission mode, the fax 
number is dialed immediately, and the scanned document will be sent. (Transmission conditions can be set in 
the transmission condition setting screen.)

 If memory becomes full during scanning in the memory transmission mode, that original will not be stored in 
memory. When that happens, reduce the number of originals you are sending, or try sending them in the direct 
transmission mode.

 You can check the status of the current sending. You can also cancel the transmission (deletes the job).
 P.50 “Checking Communication Status”
 P.53 “Canceling the Transmission”

Redial function
In the memory transmission mode, if the fax cannot be sent due to a busy-line, the fax number is redialed 
automatically to send the fax. By default, this equipment redials 3 times at 1-minute intervals.
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 Setting the transmission conditions
You can set the fax transmission conditions.

 The transmission conditions are only applied to the current transmission. They return to the default settings after 
the transmission.

 Refer to the MFP Management Guide to change the default values of each item.

 Setting the original size

You can set the original size.

1 Press  in the Fax menu.

Sending the next original
If an original is placed on the original glass and its scanning is completed, the confirmation screen for the next 
original is displayed. If you want to continue scanning of the next original, place it on the original glass, and 
then press the [START] button on the control panel. Once all the originals are scanned, press [Job Finish]. If you 
place an original on the ADF and press [Continue] during scanning, the confirmation screen for the next original 
can be displayed after the scanning is completed.

 If you leave the screen unattended for a period of the auto clearance setting time (45 sec. by default), a copy 

of the scanned originals is sent.

 To cancel the transmission in the memory transmission mode, press [Job Cancel].

 P.53 “Canceling memory transmission job”

 To change the transmission conditions for each page, press [Option].

 P.34 “Changing the settings for each page”
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2 Select the original size and press [OK].

 Original Size
Set the scan size of the original.

- Auto: The size of the original is automatically determined before the original is scanned.
- Different Width: Select this function to load the originals with different width into the ADF.
- Specified size: The original is scanned at the preset size regardless of its actual size.

 Setup items differ depending on the model.
 If the recipient’s fax machine is not capable of receiving originals of B5/B5-R size, this equipment may reduce 

that size before sending it. To avoid this, when the original to be set is B5 and B5-R size, specify A4 and A4-R 
size respectively.

 Setting the resolution

You can set the resolution when scanning an original.

1 Press  in the  Fax menu.
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2 Select the resolution and press [OK].

 Resolution
Set the resolution based on the fineness of the original.

- U-Fine: This is suitable for an original with ultra-fine illustrations.
- Fine: This is suitable for an original with small size text and fine illustrations.
- Standard: This is suitable for an original with regular size text.

 If the recipient’s fax machine is not capable of receiving originals at the same resolution, the resolution is 
automatically converted before being sent to the recipient. The higher the resolution is, the longer it takes to 
send an original.

 Standard cannot be set in Resolution while the OCR function is enabled.

 Setting other transmission conditions

1 Press [Option] in the Fax menu.
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2 Press the desired item and change the setting on the screen displayed.

 Original Size
This is the same value as the one which can be set on the Fax menu. For details, see the following page.
 P.29 “Setting the original size”

 Resolution
This is the same value as the one which can be set on the Fax menu. For details, see the following page.
 P.31 “Setting other transmission conditions”

 Original Mode
Set the scanning mode based on the type of the original.

- Text/Photo: This is suitable for an original with a mixture of text and photos.

- Text: This is suitable for an original with text and line drawings.

- Photo: This is suitable for an original with photos.

 Exposure
Set the density at which the original is to be scanned.

- Auto: This equipment automatically detects the contrast of the original, and scans it with the optimum 
density.

- Manual: Press  or  to set the desired contrast.

 2-Sided Scan
Select the type (1-sided or 2-sided) of the original to be scanned

- 1 Side: Press this button to scan a 1-sided original.

- Book: Press this button to scan a 2-sided right-to-left (book-type) original.

- Tablet: Press this button to scan a 2-sided top-to-bottom (tablet-type) original.

 Fax Setting
If you want to change each item for the Fax Setting, see the following page:
 P.33 “Changing the Fax Settings”

 Internet Fax Setting
If you want to change each item for the Internet Fax Setting, see the following page:
 P.34 “Changing the Internet Fax Settings”

 Advanced
If you want to change the advanced conditions for each item, see the following page:
 P.57 “USING THE FAX UNIT (USEFUL FUNCTIONS)”

In the [Text/Photo] or [Photo], transmission time may be longer than that in the [Text].
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Changing the Fax Settings

To cancel the operation and return to the previous screen, press [Reset].

 Tx Type
Set the fax transmission mode.

- Memory Tx: Send the original after the scanned data are saved in the memory. Up to 100 transmissions of up to 
1000 pages per 1 transmission can be reserved.

- Direct Tx: Send the original directly as it is being scanned. Once a page has been scanned and sent, the next 
page is scanned and sent. Therefore, it takes longer to scan and send all pages. However, you can confirm on the 
fly that each page is sent to the recipient.

 ECM for G3
Switch the ECM (Error Correction Mode) communication On or Off for G3 fax. ECM is an internationally standardized 
communication mode that automatically corrects errors that occur during fax transmissions. With this setting 
option On, even when the transmitted data have been affected by noise during communication, this mode allows 
good communication without image distortion by automatically resending the parts that have been affected.

 Quality Tx
Switch Quality Tx On or Off. When this mode is set to On, originals are sent at a slower speed than usual and the 
chances of errors occurring decrease.

 Line Select
Specify the line to be used for sending a fax when multiple fax units are installed.

- Auto: The line is switched automatically.
- Line 1: The 1st line is used.
- Line 2: The 2nd line is used.

 Mailbox Communication
For the communication compatible with ITU-T (International Telecommunications Union-Telecommunications) 
standards, specify a subaddress or password to be sent to the recipient’s fax machine. (Up to 20 digits can be 
entered.)

- SUB (Subaddress): Information to send data of the original to the fax machine.
- SEP (Selective Polling): Information to retrieve data of the original from the fax machine.
- SID (Sender Identification): Password for SUB.
- PWD (Password): Password for SEP.
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 Line Monitor
Switch the line monitoring function to [On] or [Off].

 Both the sender and the receiver must have the ECM function to make ECM communication available.
 When affected by noise during communication, communication time is slightly longer than usual. Even when 

the ECM communication is used, an error may occur depending on the line status.
 The ECM communication is not available for voice communication.
 The setting condition in the address book takes the priority. Therefore, when the recipient’s Quality Tx is set to 

On in the address book, a fax transmission is performed at On even though the Quality Tx remains Off in the 
Option screen.

 Line Select cannot be selected on some models.

To use the Mailbox Communication function, the recipient’s fax machine must be capable of setting an ITU-T 
compatible subaddress or password.

Changing the Internet Fax Settings

This is not applicable to standard fax sending.
 P.122 “Sending Internet faxes”

 Subject: The subject of the Internet Fax.
 Body: The body of the Internet Fax.

 Changing the settings for each page

You can change the scanning conditions (Resolution, Mode, Exposure, and Original) for each page.

1 Specify the recipients and press [Send] to start scanning a document. When the scanning of the 
original is completed, the confirmation screen for the next original is displayed. Press [Option].

The screen above is displayed when the original placed on the original glass. If you place an original on the ADF 
and press [Continue] during scanning, the confirmation screen for the next original is displayed after the 
scanning is completed. If you press [Stop] displayed on the screen during scanning, it will be halted and the 
confirmation screen for the next original can be displayed.

2 The setting screen for the scanning conditions is displayed. Change the settings, and then press 
[OK].
 P.31 “Setting other transmission conditions”
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 Specifying the recipient
There are various ways to specify the recipient, such as direct entry with the control panel and address book entry.

 To use the address book, you need to register recipients’ fax numbers to the book in advance. For details of the 
operation, refer to the MFP Management Guide or TopAccess Guide.

 To send to multiple addresses
In the memory transmission mode, you can send the same document to multiple recipients (up to 400 recipients) at 
once. When [Multi] is pressed after the fax number has been entered, it will be added to the recipient list displayed 
on the left-hand side of the screen. Repeat this operation until you specify all recipients. You can also specify up to 
a total of 400 recipients’ fax numbers by combining with other entry methods.

 Entering directly with digital keys

You can specify the recipient by entering its fax number on the touch panel.

1 Press .

2 Key in the recipient’s fax number and press [Send].

Press  to key in the recipient’s E-mail address (internet fax) directly.
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 Specifying the recipient in the address book

In the address book, you can specify the recipient.

1 Press the desired recipient on the  tab.

 To cancel the selected recipient, press it again.

 To confirm the selected recipient or delete an unnecessary recipient, press it in the recipient list displayed on 
the left-hand side of the screen.
 P.39 “Confirming/Deleting the recipients”

 To refine your search only for items including specified characters, press .

 P.36 “Searching from the address book or LDAP server”

When you set your favorite or index items in the address book in the registration, the corresponding recipients 

appear on the  (favorite) tab or index tab.

 Searching from the address book or LDAP server

You can search for the recipient’s fax number from the address book or LDAP server.

To search for the recipient’s fax number from the LDAP (Lightweight Directory Access Protocol) server, the name of 
the LDAP server to be connected is required to be registered to the MFP in advance. For details on the LDAP server, ask 
your network administrator.

1 Select the  or  tab and press .

 To display the recipient search menu, press  while the address list is displayed.

 To display the group search menu, press  while the group list is displayed.
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2 Enter the keyword in the category which you want to use for searching. Press [Search].

You can search for the desired recipient’s fax number by specifying multiple keywords.
You can search for contacts even if you enter the partial strings. If you enter multiple search conditions, only the 
contacts which meet all the entered conditions are displayed as the search results.

 Location
Select a location where the address book to be searched is stored. By selecting “MFP Local”, you can search 
the address book of this equipment and a shared address book.

 Known ID
Use it when you want to search with the Known IDs registered in the address book. You can specify the range 
of the ID numbers.

 Index
Use this when you want to search with the index registered in the address book.

 First Name
Use this when you want to search with the first name registered in the address book.

 Last Name
Use this when you want to search with the last name registered in the address book.

 Corp.
Use this when you want to search with the corporate name registered in the address book.

 Dept.
Use this when you want to search with the department registered in the address book.

 Keyword
Use this when you want to search with the characters written in the Keyword which are registered in the 
address book.

 Fax No.
Use this when you want to search with the fax number registered in the address book.

 E-mail
Use this when you want to search with the E-mail address registered in the address book.

 Send Type
Use this when you want to search either fax number or E-mail address.
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3 The search result is displayed. Select the desired recipient and press [Send].

 To cancel the selected recipient, press it again.

 If you want to change the results of the search, press [Research]. You will be returned to the screen in step 2. 
Specify the search string again.

 You can switch the screen by selecting [Known ID Sort] or [Index Sort].

Selecting the LDAP server
To search for the recipient’s fax number in the LDAP server, select the one you want to search in the pull-
down menu of Location on the Search screen.
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 Specifying the group in the address book

In the address book, you can specify the group to which you want to send a fax.

1 Press the  tab to select the group to send a fax to.

 To cancel the selected group, press it again.

 To confirm the fax number or the E-mail addresses registered in the group, press [Contents].

 To delete an unnecessary recipient, press it in the recipient list displayed on the left-hand side of the screen.
 P.39 “Confirming/Deleting the recipients”

 To refine your search only for items including specified characters, press .

 P.36 “Searching from the address book or LDAP server”

 Confirming/Deleting the recipients

You can confirm the recipients which you specified or delete unnecessary recipients.

1 Select the recipient to confirm from the recipient list displayed on the left-hand side of the 
screen.

Details of the selected recipient appear.

 Details of the members included in the group cannot be confirmed with this operation. Press [Contents] when 
the group is selected.
 P.39 “Specifying the group in the address book”

 Press [Clear All Dest.] to delete all recipients displayed in the list.
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2 Confirm the recipients on the screen displayed. Press [Clear] to delete the recipients or groups 
from the recipient list.

3 When [Clear] is pressed, a confirmation message will appear. Press [OK].
The recipients selected are deleted from the recipient list.

 Displaying the preview before sending a fax
Before sending a fax, you can check the image on the touch panel with this preview function.

When dialing on-hook transmission or off-hook transmission, you cannot use the preview function.

1 Press [Preview] on the fax menu.

To use the preview function, press [Preview] before pressing [Send].

2 Specify the recipient and set the transmission conditions. Press [Send].

For details about how to specify the recipient and set the transmission conditions, see the following pages.
 P.29 “Setting the transmission conditions”
 P.35 “Specifying the recipient”
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3 Carefully check the displayed preview of your scans and the number of pages. To save or E-mail 
your scans, press [OK].

 The number of pages of your scanned original is displayed on the upper right of the screen.

 If you want to scan another original continuously, place it on the original glass or in the ADF, and then press 
the [START] button.

 When the page to confirm is selected, it is enlarged and the preview operation, such as the enlargement/
reduction of the display or the replacement/insertion of a page, becomes possible.

 To replace the page being previewed with another page, press [Replace Page], place a new original and press 
[OK].

 To insert another scan before the page being previewed, press [Insert Page].

 To delete the page being previewed, press [Edit] and then  on the page to be deleted.

However,  is not displayed if only one page is being previewed.

 To change the setting, press [Option].
 P.29 “Setting the transmission conditions”
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On-hook transmission/Off-hook transmission

 On-hook transmission

You can dial and perform direct fax transmission without picking up the handset of the external telephone. On-hook 
Transmission is available when  on the upper right of the screen is OFF.

On-hook transmission using a 2nd line is not available.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Press [Monitor].

 Make sure that you hear the dial tone from the built-in speaker.

 To cancel the operation, press [Monitor] again.

When you specify the recipients by searching them, perform the next procedure in advance. In this case, specify 
the recipients, and then press [Dial].

5 Specify the recipients.
 P.35 “Specifying the recipient”

 For direct entry, press  to dial a number. If you make a mistake when dialing the fax number, press 

[Monitor] to cut the line, and then press it again to redial.
 If you specified the recipient with the search, press [Dial].

6 When you hear the answer tone (short high-pitched tone) through the built-in speaker indicating 
the connection has been made with the recipient’s machine, press [Send].
 P.27 “Sending a Fax”

When you hear the other party’s voice answering the call before pressing [Send], pick up the handset of the 
external telephone. Then ask him/her to perform operation of the fax reception.



2.USING THE FAX UNIT (BASIC OPERATION)

Operating the Fax unit    43

U
S

IN
G

 T
H

E FA
X

 U
N

IT
 (B

A
S

IC
 O

P
ER

A
T

IO
N

)

 Off-hook transmission

You can pick up the handset of the external telephone to dial and perform direct fax transmission. Off-hook 
Transmission is available when  on the upper right of the screen is OFF.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Press [Option] and set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Pick up the handset of the external telephone.

When you specify the recipients by searching them, perform the next procedure in advance. Press [Dial] after 
specifying the recipients.

5 Use the external telephone to dial the fax number.
 P.35 “Specifying the recipient”

 When you use the external telephone to dial, the machine dials each number you enter. If you make a mistake 
when dialing the fax number, replace the handset to cut the line, and then pick up the handset again to redial.

 When you specify the recipients by searching them, press [Dial].

6 When you hear the answer tone (short high-pitched tone) through the built-in speaker indicating 
the connection has been made with the recipient’s machine, press [Send].
 P.27 “Sending a Fax”

When you hear the other party’s voice answering the call before pressing [Send], ask him/her to perform 
operation of the fax reception.

7 Replace the handset of the external telephone.
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0.Receiving a Fax

Originals and paper

 Acceptable size of paper

A3, B4, A4, B5, A5, FOLIO, LD, LG, LT, ST and COMP sized paper are available. For the e-STUDIO400AC Series, A4, B5, A5, 
FOLIO, LG, LT, ST sized paper are available.
The printing range of each size of paper is as follows: If an original contains any information outside of the printable 
area, it is not printed on the paper.

 e-STUDIO5015AC Series: Leading edge 4.2 mm (0.17"), Trailing edge 3 mm (0.12"), Both edges 2 mm (0.08")
 e-STUDIO5018A Series: Leading edge 3 mm (0.12"), Trailing edge 2 mm (0.08"), Both edges 2 mm (0.08")
 e-STUDIO7516AC Series: Leading edge 4.2 mm (0.17"), Trailing edge 2 mm (0.08"), Both edges 2 mm (0.08")
 e-STUDIO8518A Series: Leading edge 3 mm (0.12"), Trailing edge 2 mm (0.08"), Both edges 2 mm (0.08")
 e-STUDIO400AC Series: Leading edge 4.2 mm (0.17"), Trailing edge 4.2 mm (0.17"), Both edges 4.2 mm (0.17")

When B5 size paper is used, set B4 size paper in another drawer.

 Set the paper in the drawers or the Large Capacity Feeder. The bypass tray is not available.
 Regardless of whether or not the Finisher is installed, paper exits on the receiving tray.
 Drawers can be set for fax use only. For details of the operation, refer to the Paper Preparation Guide.

 Default setting for Rx printing

To print the received fax, the paper with the same width as the original is used. Depending on the length of the 
original, “Rx reduction printing” or “Discard printing” (both of them are set to ON by default) are applied.
 For details about the setting Rx printing, refer to the MFP Management Guide.

When an original is shorter or the same as the paper printing area
It is printed in the original size.

When an original is longer than the paper printing area
It is printed according to the following priority:

 When an original is up to 10 mm (0.4") longer than the printing area: the part of the originals that exceeds the paper 
printing area is discarded.

 When an original exceeds the printing area by more than 10 mm (0.4"): the original image is reduced to 75 % 
(reduction printing). If the image still cannot be fitted into the printing area, paper larger than the original is 
selected. In case there is no larger paper available, the original is printed with the image divided.
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 Paper priority when there is no same size paper

When both “Rx reduction printing” and “Discard printing” are set to ON, paper is selected according to the following 
priority:

1. Paper of the same size and the same orientation as the original
2. Paper of the same size but with a different orientation to the original
3. Paper of the same orientation but larger than the original

North American format

 The selectable paper sizes differ depending on the models.
 When the corresponding paper size is not available, in most cases, the scanned original is printed on paper of a 

larger size. However, the sender’s fax machine may reduce the scanned original to fit the paper size available in the 
recipient’s fax machine (this equipment). (Ex. LD to LT)

 The paper priority varies according to the “Rx reduction printing” and “Discard printing” settings. For details, 
contact your service technician.

Size of Original
being Received

Priority Ledger Legal

Legal

Letter Letter Statement COMP

Letter

Letter

StatementLedger Letter Letter COMP

Ledger

Legal

Legal

COMP

Ledger

Ledger

Letter

Legal

COMP

Letter Letter Letter LedgerCOMP

Ledger

COMP Legal

1

2

3

4

5

6
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A/B format

 The selectable paper sizes differ depending on the models.
 When the corresponding paper size is not available, in most cases, the scanned original is printed on paper of a 

larger size. However, the sender’s fax machine may reduce the scanned original to fit the paper size available in the 
recipient’s fax machine (this equipment). (Ex. A3 to A4)

 The paper priority varies according to the “Rx reduction printing” and “Discard printing” settings. For details, 
contact your service technician.

A3 A4 A5

A5-R

A4-R

A4-R

A4-R

A4 A4-R

B4

A3 B4

B5

A4-R

A4

B5

B5-RA3

A3

B5

B4

A3

1

2

3

4

5

6

7

8

FOLIO

FOLIO

FOLIO

B4

FOLIO

B4

A3B4

B4 A4

A3

A3

FOLIO

Size of Original
being Received

Priority

A4

B5-R

FOLIO
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 Reception mode
This section describes how to receive a fax. Refer to the appropriate section for your current reception mode. The 
reception mode can be set on the Admin menu. For details of the current setting, ask your administrator. Besides the 
receiving methods described in this section, there are various useful ways to receive a fax. These procedures are 
described in the following pages.
 P.59 “Communicating to a Request from a Recipient (Polling Communication)”
 P.61 “Using the Mailbox Function”

Fax reception settings can be changed from TopAccess. 
For details of the operation, refer to the TopAccess Guide.

 Auto reception

Faxes are automatically received during an incoming call. Users do not have to do anything when receiving a fax.

When multiple fax units are installed, the reception mode of the 2nd line is limited to “Auto reception”.

 Manual reception

Faxes are manually received by using an external telephone when you have an incoming call.

1 Pick up the handset of the external telephone when you have an incoming call.
If the incoming call is a telephone call, you can start talking.

2 When you hear a tone (fax signal) through the handset of the external telephone, press [Fax] on 
the Home screen.

3 Press the [Manual Rx].

4 When a message indicating that you can receive a fax appears, press [Receive] on the touch panel 
or the [START] button on the control panel. Replace the handset of the external telephone.
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 Memory reception

The received fax data are stored in the memory, the faxes are automatically printed as soon as the equipment 
becomes ready. As the memory reception function is always enabled, you do not need to make any setting.

 Displaying the preview of a received fax

You can confirm the contents on the touch panel before carrying out the printing of a fax received by means of the 
[Hold (Fax)], [Secure Rx (Line 1)] and [Secure Rx (Line 2)] option.

1 Press [Print] on the Home screen.
The print screen is displayed. If you leave the screen unattended for the auto clear setting time (45 sec. by 
default), the screen returns to the default one automatically.

2 Select [Hold (Fax)], [Secure Rx (Line 1)] or [Secure Rx (Line 2)] for Job Type.
If the equipment is running in the High Security mode, [Secure Rx (Line 1)] and [Secure Rx (Line 2)] are not 
displayed.

 When  is pressed, received fax jobs are displayed in the list.
 To delete a received fax from the list, select the received file subject to delete and press [Delete].

When  is pressed, received fax jobs are displayed in thumbnail images.
 To delete a received fax from the thumbnail, select the thumbnail image subject to delete and press [Delete].
 The entry of the password is required at the first operation of any of [Delete], [Print], [Display Image] or the 

thumbnail images.

3 Press [Display Image].

4 Enter the password for printing secure receive fax jobs.

After the password is entered and then [OK] is pressed,  mark in the Unchecked field disappears. When the 
screen is shifted to another one and then is returned to this one, the entry of the password is required when 
preview or printing is carried out.
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5 When the preview is displayed, confirm the fax image and the number of pages. To print a 
received fax as it is, press [Print]. Printing starts.

 When a page to confirm is selected, it is enlarged and the preview operation, such as the enlargement/
reduction of the display or the rotation of the page, becomes possible.

 Press  on the page to be rotated. The page is rotated by 90 degrees by each one time  is pressed.

 Uncheck  of the pages which will not be printed.

When printing is performed by specifying the page, the received fax is not deleted even if all pages are selected. 
Print or delete the received fax on the screen in step 3.



50    Checking Communication Status

0.Checking Communication Status

 Checking reserved transmissions
You can check reserved fax transmissions.

1 Press [Job Status].

2 Press [Fax].

 Reserved transmission jobs are listed up to 100 transmissions in the chronological order from top to bottom.

 To print the list of the reserved transmissions jobs, press [Reservation List].

 In the “Status” column, the status of each job is indicated as follows:

- Line1: Sending on the 1st line.

- Line2: Sending on the 2nd line.

- Network: Reserved for sending via Internet Fax.

- Delayed: Reserved with the time to send specified.

- Wait: Communication is in the standby queue.

- Invalid: Under standby due to an invalid department code (Network Fax). Confirm the department code and 
delete any unnecessary reserved transmissions in the standby queue. For each operation, see the following 
pages.

 P.102 “Setting up the [Send] tab”

 P.55 “Canceling reserved transmissions”

The 2nd line for FAX Unit is not available to some models.



2.USING THE FAX UNIT (BASIC OPERATION)

Checking Communication Status    51

U
S

IN
G

 T
H

E FA
X

 U
N

IT
 (B

A
S

IC
 O

P
ER

A
T

IO
N

)

 Checking communication log
You can check the log of fax transmissions and receptions.

1 Press [Job Status].

2 Select the [Log] tab, and then press [Send] or [Receive].

3 The list of the communication status is displayed.

 Transmissions or receptions are listed in the reversed chronological order from top to bottom.

 Up to the latest 40 or 120 transmission/reception records can be listed on the log. The maximum number can 
be set on the Admin menu. For details of the operation, refer to the MFP Management Guide.

 To print the log of transmissions or receptions, press [Journal].
 P.83 “Journal (transmission journal/reception journal)”

 In the “Status” column, the status is indicated as follows:
OK: Transmission or reception succeeded.
4-digit error code: Transmission or reception failed.
For details about the error codes, refer to the Software Troubleshooting Guide.
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 The Send and Receive logs can be downloaded to a USB storage device. For details, refer to the MFP 
Management Guide.

Registering recipients’ fax numbers to the address book
To register recipient’s fax numbers in the address book from the send/receive log screen, select a record in 
the send or receive log, and then press [Entry]. For details of the registration to the address book, refer to 
the MFP Management Guide.

 Fax and E-mail transmissions whose recipients are specified with direct entry or entry using the LDAP 

server can be registered to the address book from the Send log.

 Polling and E-mail receptions whose recipients are specified with direct entry or entry using the LDAP 

server can be registered to the address book from the Receive log.
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0.Canceling the Transmission

 Canceling memory transmission job
You can cancel the memory transmission during scanning.

 When using the original glass

This section describes how to cancel the memory transmission when an original is placed on the original glass.

1 When scanning is completed, the confirmation screen for the next original is displayed. Press 
[Job Cancel].

If you leave the screen unattended for a period of the auto clearance setting time (45 sec. by default) after the 
confirmation screen for the next original is displayed, a copy of the scanned originals is sent.

2 The confirmation screen is displayed. Press [Yes].
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 When using the ADF

This section describes how to cancel the memory transmission when originals are placed on the ADF.

1 Press [Stop] displayed on the screen while the originals are being scanned.
Scanning is paused.

2 The confirmation screen for the next original is displayed. Press [Job Cancel].

 If you press [Job Finish], the scanned originals are sent.

 If you leave the screen for the next original unattended for the period of the auto clear setting time (45 sec. by 
default) after it appears, the scanned originals are sent.

3 The confirmation screen is displayed. Press [Yes].
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 Pausing transmission
You can stop a transmission job during scanning.

Even if you cancel transmission in the direct Tx mode, the part of the original that was scanned before transmission is 
canceled has been sent.

1 Press [Stop] displayed on the screen while the originals are being scanned.
The scanning and transmission are stopped.

 Canceling reserved transmissions
You can display the list of the reserved transmissions, and cancel the reserved transmissions that are in the queue or 
in progress.

1 Press [Job Status], and then press [Fax].
The list of the reserved transmissions is displayed. This step is the same as that for checking the reserved 
transmission.
 P.50 “Checking reserved transmissions”

2 Select the reserved transmission you want to delete, and then press [Delete].
More than one job can be selected.

In the “Status” column, you can check the status of the reservation. “Wait” indicates that the data are waiting to 
be sent. “Line1” or “Line2” indicates that the data are being sent. Delayed transmission reservation and polling 
transmission/reception can be canceled.

3 The confirmation screen for the deletion is displayed. Press [Delete].
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This chapter describes useful functions of the FAX Unit.

Prioritizing Transmissions (Priority Reserve)......................................................................58
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E-mailing Data Received Via the Mailbox (Onramp Gateway)................................................75
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Specifying the network folder .............................................................................................................................79
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Printing Lists & Reports Manually .......................................................................................................................83
Printing Lists & Reports Automatically ...............................................................................................................85
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0.Prioritizing Transmissions (Priority Reserve)

You can send a fax prior to other reserved transmissions (including redial standby).

Note that each setting will automatically return to its default setting when transmission is completed.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Press [Option] > [Advanced] > [Priority Reserve].

5 Press [OK].

6 Specify the recipient’s fax number.
 P.35 “Specifying the recipient”

In the priority transmission mode, you cannot specify multiple recipients’ fax numbers.

7 Press [Send].
 P.27 “Sending a Fax”
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0.Communicating to a Request from a Recipient (Polling Communication)

The polling communication function allows you to receive pending originals in the sender’s fax machine by manually 
operating the receiving fax machine. In this document, the operation in which this equipment is used as the sender’s 
fax machine is called “polling transmission” while that in which it is used as the recipient’s fax machine is called as 
“polling reception”.

 Storing data of originals in the memory (polling transmission)
Upon request of a recipient’s fax machine, this equipment sends an original document stored into the memory to the 
recipient. By setting a recipient’s fax number to an original stored into the memory, you can permit specific recipients 
to receive the original using the polling transmission.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Press [Option] > [Advanced] >  [Polling Reserve].

5 If you set the fax number (the recipient’s telephone number), key in the number (maximum 20 
digits), and then press [OK].

If you don’t have to set the fax number, leave it blank and press [OK].

6 Press the [START] button on the control panel.
 Upon request of the recipient’s fax machine, the data of the original stored into memory are sent 

automatically. Once they are sent, they are deleted from memory.

 You can delete the data of the original from memory by canceling the polling transmission.
 P.50 “Checking reserved transmissions”
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 Requesting to send data of originals (polling reception)
This equipment requests the sender’s fax machine to send the data of the originals.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] >  [Polling].

3 Press [OK].

4 Specify the sender’s fax number.
 P.35 “Specifying the recipient”

This equipment supports two types of receptions: Individual polling reception in which you specify a recipient’s 
fax number and Multi-polling reception in which you specify multiple recipients’ fax numbers.

5 Press [Send].
 P.27 “Sending a Fax”

With the delayed transmission reservation, you can perform the polling reception on a specific date and time. To 
do that, set the date and time before pressing [Send].
 P.73 “Sending Faxes at Specified Dates and Times (Delayed Transmission Reservation)”
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0.Using the Mailbox Function

This function is used to communicate between fax machines compatible with a mailbox function (ITU-T compatible). 
The owners of these fax machines can input or retrieve the data of the originals in the mailbox.
There are 3 types of mailbox: confidential mailbox, bulletin board mailbox and relay station mailbox. To perform 
mailbox communication, the mailboxes must be created in advance. An individual password for each box can be set 
for security protection.
 P.67 “Creating, modifying, and deleting a mailbox (mailbox transmission)”

 Confidential mailbox
Once data of an original are retrieved from this mailbox, these data will be deleted. This mailbox is suitable for 
registering an original you want to send to a specific recipient. If a new original is registered in this mailbox in which 
another original exists, the mailbox will contain both of the originals.

 Bulletin board mailbox
No matter how many times an original is retrieved from this mailbox, the original will not be deleted. This mailbox 
is suitable for registering an original you want to send to multiple recipients. If a new original is registered in this 
mailbox in which another original exists, the existing original will be replaced with the new original and the new 
one will be stored in the mailbox.

 Relay station mailbox
Using this mailbox, an original sent from a fax machine is relayed to pre-registered multiple recipients. To inform a 
user of the result of the relay, a report called RELAY TX END TERMINAL REPORT can be sent to a specific recipient. A 
copy of the original can be printed out (regularly or when an error occurs).

<Example of how to use the relay station mailbox>
If you want to send a copy of an original from an office in Los Angels to multiple offices in New York, you first send it 
from the one in Los Angels to one of the offices in New York where the relay station mailbox is set up, so that it is 
relayed to the other offices in New York. This will reduce communication costs.

If you create a forward mailbox whose number is the fax number of the sender, you can use the TSI function. Using 
this function, this equipment forwards the original sent from the sender whose fax number is set to the mailbox 
number, based on the pre-set agent (Save as File / Email / Store to e-Filing). This can be set from TopAccess. For 
details of the operation, refer to the TopAccess Guide.

LA office
(213)

NY office A
(Relay Mailbox)

(212)NY office A
(212)

NY office B
(212)

NY office C
(212)

LA office
(213)

VIA RELAY MAILBOX

NY office B
(local)

NY office C
(local)

NY office D
(local)

* 4 long-distance calls

NY office D
(212)

NORMAL

Relay Originator

Relay Station

Relay
Destination

* 1 long-distance call to the NY office A 
(relay mailbox) and 3 local calls between 
the NY office A (relay mailbox) and each 
office.
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 Registering, printing, and deleting originals (mailbox transmission)
This section describes the operations of the mailbox in the equipment.

 Registering originals

You can register originals to the confidential or bulletin board mailbox in the equipment.

To register the originals to confidential or bulletin board mailbox, the confidential or bulletin board mailbox must be 
created in advance.
 P.67 “Creating, modifying, and deleting a mailbox (mailbox transmission)”

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Press [Option] > [Advanced] >  [ITU Mailbox].

5 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press 
[Input], and then press [OK].
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6 Key in the box number and then press [OK].

If a password has been set to the selected bulletin board mailbox, key in the password in the same way as the box 
number. If you have selected the confidential mailbox, it is not necessary to key in a password since it is not 
verified.

7 Press the [START] button on the control panel.
When you cancel the registration, press [Stop] displayed on the screen and then press [Job Cancel].

 Printing originals

You can print the originals registered in the confidential or bulletin board mailbox in the equipment.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press 
[Print], and then press [OK].

4 Key in the box number.

If a password has been set to the selected confidential mailbox, key in the password in the same way as the box 
number. If you have selected the bulletin board mailbox, it is not necessary to key in a password since it is not 
verified.



3.USING THE FAX UNIT (USEFUL FUNCTIONS)

64    Using the Mailbox Function

5 Press the [START] button on the control panel.

 Deleting originals

You can delete the originals registered in the confidential or bulletin board mailbox in the equipment.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press 
[Cancel], and then press [OK].

4 Key in the box number and then press [OK].

If a password has been set to the selected mailbox, key in the password in the same way as the box number.

5 The confirmation screen for the deletion is displayed. Press [Yes].
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 Sending and retrieving originals (mailbox transmission)
This section describes the operations to the mailboxes in the recipient’s fax machine.

 Sending originals

You can send originals to the confidential/bulletin board/relay station mailbox in the recipient’s fax machine.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Press [Option] > [Advanced] > [ITU Mailbox].

5 In the “Box Type” group, press [Confidential], [Bulletin Bd.] or [Relay]. In the “Mode” group, 
press [Transmit], and then [OK].
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6 Key in the box number and then press [OK].

If a password has been set to the selected mailbox, key in the password in the same way as the box number.

The box number and the password you specified here are sent to the recipient’s fax machine as SUD (box 
number) and SID (password) of the command compatible with the ITU-T standards.

7 Specify the recipient’s fax number.
 P.35 “Specifying the recipient”

8 Press [Send].
 P.27 “Sending a Fax”

You can cancel the transmission of the original.
 P.53 “Canceling the Transmission”

 Retrieving originals

You can retrieve originals from the confidential or bulletin board mailbox in the recipient’s fax machine.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press 
[Polling], and then [OK].
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4 Key in the box number and then press [OK].

If a password has been set to the selected mailbox, key in the password in the same way as the box number.

The box number and the password you specified here are sent to the recipient’s fax machine as SUD (box 
number) and SID (password) of the command compatible with the ITU-T standards.

5 Specify the recipient’s fax number.
 P.35 “Specifying the recipient”

6 Press [Send].
 P.27 “Sending a Fax”

 Creating, modifying, and deleting a mailbox (mailbox transmission)
This section describes how to manage the mailbox in the equipment.

In the list, you can view the status of the mailbox registered to the equipment.
 P.131 “MAILBOX/RELAY BOX REPORT”

 Creating the confidential or bulletin board mailbox

You can create the confidential or bulletin board mailbox in the equipment.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].
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3 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press [Box 
Setup], and then [OK].

4 Key in the box number (a maximum of 20 digits) and then press [OK].

If you want to set a password (a maximum of 20 digits), key in the password in the same way as the box number.
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 Creating/modifying a relay station mailbox

You can create or modify the relay station mailbox.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Relay]. In the “Mode” group, press [Box Setup] or [Modify], and 
then [OK].

4 Key in the box number (a maximum of 20 digits) and then press [OK].

If you want to set a password (a maximum of 20 digits), key in the password in the same way as the box number.

5 Specify the recipient to be registered, and then press [OK].
 P.35 “Specifying the recipient”

Specify the recipient from the address book because this cannot be done with direct dialing.
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6 The confirmation screen for sending a relay transmission report is displayed. If you want to send 
the report, select [Yes]. If not, select [No].

By default, the relay transmission end terminal report is sent when a communication error occurs. On the Admin 
menu, you can make setting so that the report can be sent automatically. For details of the operation, refer to the 
MFP Management Guide.

7 Specify the recipient to which you want to send the report, and then press [OK].
 P.35 “Specifying the recipient”

Only one recipient can be specified.

8 The confirmation screen for printing the received copy of the original is displayed. If you want to 
print it out whenever a copy of the original is delivered, press [Always]. If you want to print it out 
only when an error occurs, press the [On Error].
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 Deleting a mailbox

You can delete the confidential/bulletin board/relay station mailbox registered in the equipment.

The confidential and bulletin board mailbox in which the original is registered cannot be deleted. To delete the 
mailbox, delete the original in advance.
 P.64 “Deleting originals”

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Confidential], [Bulletin Bd.] or [Relay]. In the “Mode” group, 
press [Box Delete], and then [OK].

4 Key in the box number and then press [OK].

If a password has been set to the selected mailbox, key in the password in the same way as the box number.

5 The confirmation screen for the deletion is displayed. Press [Yes].
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0.Dialing numbers by Chaining Multiple Sets of Numbers (Chain Dial Communication)

You can chain pre-registered sets of numbers to form a dialing string. For example, you can form the desired number 
by specifying sets of numbers registered in the address book sequentially such as region code, area code and fax 
numbers.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Press [Option] > [Advanced] > [Chain Dial Comm.].

5 Repeat this operation until the desired number is formed.
 P.35 “Specifying the recipient”

You can form the dialing number which is up to 128 digits in length. The numbers are chained in the order you 
specify them.

To send faxes to several recipients, press [OK] for each selection of a recipient to set the entry.

6 Press [Send].
 P.27 “Sending a Fax”
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0.Sending Faxes at Specified Dates and Times (Delayed Transmission Reservation)

You can send a fax at a specified date and time. It is useful when you want to make use of off-peak discounts (e.g. 
nighttime) or you want to send a fax to a country which has a time difference.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

4 Press [Option] > [Advanced] > [Delayed Tx Reserve].

5 Key in the date, hour and minute, and then press [OK].

 The acceptable range of reservation is up to one month later.

 Specify the time on a 24-hour basis.

6 Specify the recipient’s fax number.
 P.35 “Specifying the recipient”

7 Press [Send].
 P.27 “Sending a Fax”

Canceling delayed transmission reservation
You can cancel the delayed transmission reservation and send a fax in a normal manner. On the reserved 
transmission confirmation screen, select the transmissions job, and then press [Send].
 P.50 “Checking reserved transmissions”
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0.Resending Unsent Data (Recovery Transmission)

You can save the data of originals, which were not sent after redialing a specified number of times, in the memory and 
resend them without placing the originals. Enabling or disabling this function or a period of time for the data to be 
retained can be set on the Admin menu. For the details of the current setting, ask your administrator.

1 Press [Fax] on the Home screen.

2 Set the transmission conditions.
 P.29 “Setting the transmission conditions”

3 Press [Option] > [Advanced] > [Recovery Tx].

4 Select the transmission job, and then press [Send].

 You can change the fax number which is specified with the direct entry method.

 To delete the selected transmission job, press [Job Cancel].
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0.E-mailing Data Received Via the Mailbox (Onramp Gateway) 

The onramp gateway function allows for an original sent from another mailbox-supported fax machine to be 
converted into E-mail data, which will be sent to a pre-registered E-mail address, via the mailbox (relay station) in this 
equipment.

Fax numbers and E-mail addresses can be registered to the mailbox used for an onramp gateway transmission. That 
mailbox is the same as the one used for the mailbox transmission. For details of how to create/modify/delete a relay 
station mailbox, see the following section.
 P.67 “Creating, modifying, and deleting a mailbox (mailbox transmission)”

To use the onramp gateway, you need to set an E-mail address and Internet Fax to the equipment. For details of the 
operation, refer to the TopAccess Guide.

ITU-T Compatible 
G3 Fax machine

Internet
Intranet

MFP
(this equipment)

Relay Box
Internet Fax 
machine

Client Computer

Mail ServerMail Server

Mail Server

2. The fax is converted to an E-mail 
and sent to the E-mail address 
registered in the Relay Box.

3. The E-mail (Internet Fax) is received 
through the Network.

3. The E-mail is received through the 
Network.

1. A fax is sent to the Relay Box 
of the equipment through the 
public telephone line.
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0.Sending Data Received by E-mails Via the Mailbox (Offramp Gateway)

The offramp gateway function allows for E-mail or Internet Fax sent from another device to be converted into 
standard fax data via this equipment, which will be sent to the recipient specified by the sender via a public telephone 
line. This is useful in reducing communication costs by using a combination of both the Internet and public telephone 
lines. For example, when sending documents long distances, such as overseas, the Internet can be used to send the 
document to a machine in the country of destination and then it will be forwarded to a target fax machine as fax data 
via a public telephone line.

Specifying an E-mail address
When you want to use this equipment as a relay station to perform an offramp gateway transmission, ask the sender 
to specify an E-mail address as follows.

 FAX=xxxxxxxx@FQDN
The fax number of the final recipient is specified in “xxxxxxxx”.
e.g.: In case that the fax number is “1234567890” and the domain name of this equipment (FQDN) is 
“host1.example.com”, the fax should be sent to
FAX=1234567890@host1.example.com

Sending to a subaddress

 FAX=xxxxxxxx/T33S=yyyy@FQDN
The fax number of the final recipient is specified in “xxxxxxxx” and the subaddress in “yyyy”.
e.g.: In case that the fax number is “1234567890”, the subaddress is “1234”, and the domain name of this 
equipment (FQDN) is “host1.example.com”, the fax should be sent to
FAX=1234567890/T33S=1234@host1.example.com

Setting up the SMTP server
SMTP is a server protocol for sending and receiving E-mails. To use the offramp gateway function, you need to set up 
the SMTP server so that this equipment can receive E-mails and Internet Fax using SMTP. For details of the operation, 
refer to the TopAccess Guide.

MFP
(this equipment)

Subaddress 
Destination

Mail Server
(SMTP)

1. The domain name of this equipment 
and the fax number of the final 
recipient are specified and an Internet 
Fax is sent.

2. The E-mail and the Internet 
Fax in which the domain name 
of this equipment is specified 
are received, and are sent to 
this equipment.

3. The received E-mail and the Internet 
Fax are converted to the standard 
fax, and are sent to the final 
recipient’s fax machine.

1. The domain name of this equipment 
and the fax number of the final 
recipient are specified and an E-mail 
is sent.

4. If a subaddress is specified in the recipient of the 
received fax, the fax is sent to the subaddress 
destination.

G3 Fax machine

Internet
Intranet

Internet Fax 
machine

Client Computer

Mail Server

Mail Server
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0.Saving Transmitted Fax Data to the Shared Folder

While sending a fax, you can save the fax as a file to a shared folder in the equipment or in a client computer. That file 
can be accessed from client computers on a network. To save a fax as a file into a shared folder in a client computer, 
you must make the “Save as file” setting of the equipment in advance. For details of the operation, refer to the 
TopAccess Guide.

 Be sure to back up the files in the shared folder to protect them from unexpected data loss events.
 If the forced encryption function for PDF security* is enabled, this function is not available. For the details of the 

security settings, refer to the MFP Management Guide.

* The PDF security may not be available depending on the equipment.

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen and make settings as required.

3 Press [Storage].

4 Select a file destination.

 [MFP Local] — Press this button to store files in a shared folder of this equipment.

 [Remote 1], [Remote 2] — Press this button to store files in a network folder, which is the shared folder of a 
computer connected with this equipment by network.

Storing data in a network folder requires the administrator to set the equipment configuration. For details, refer 
to the TopAccess Guide.

 If saving data in a network folder is enabled by the administrator and if the file destination is specified by the 
administrator, the network path for the destination is displayed on the right side of [Remote 1] or [Remote 2]. 
If the network path is not displayed, you need to specify a file destination. For details, see the following page.
 P.79 “Specifying the network folder”

 If saving data in a network folder is enabled by the administrator, you can select 2 file destinations from [MFP 
Local], [Remote 1] and [Remote 2].
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5 Make the settings for the files to be saved.

 File Name
The file name can consist of a maximum of 128 characters. However, the trailing characters in a file name 
(maximum 74) may be deleted depending on the type of letters used.

 File Format

- [PDF] — Press this button to store your scan as a PDF file.

- [TIFF] — Press this button to store your scan as a TIFF file. The OCR function cannot be used in this file 
format.

- [XPS] — Press this button to store your scan as an XPS file. The OCR function cannot be used in this file 
format.

- [DOCX] — Press this button to store your scan as a DOCX file. You can select this only when the OCR function 
is enabled.

- [XLSX] — Press this button to store your scan as an XLSX file. You can select this only when the OCR function 
is enabled.

- [PPTX] — Press this button to store your scan as a PPTX file. You can select this only when the OCR function 
is enabled.

 Multi/Single Page

- [Multi] — Press this button to store your scan as a multiple page file. When you scan several pages, the 
equipment stores all the pages as a single file.

- [Single] — Press this button to store your scan as a single file for each page. When you scan several pages, 
the equipment stores each page as a separate file.

 OCR
Press this button to enable or disable the OCR function.

 The data are saved in a shared folder with the file format which is set here.
When an OCR file format is selected, it is applied to only the data saved in a shared folder.

 When a file is saved in the shared folder of the internal storage device in the MFP, it is saved in the “TXFAX” 
folder under the “FILE_SHARE” folder. When PDF-SINGLE, TIFF-SINGLE, or XPS-SINGLE is selected, another 
folder with the same file name is automatically created in the “TXFAX” folder in which the file is saved.

 It is necessary to install the OCR option to use the OCR function. For details, refer to the Scanning Guide.

6 Specify the recipient’s fax number.
 P.35 “Specifying the recipient”

7 Press [Send].
 P.27 “Sending a Fax”

When fax transmission is completed, storing of the data of the original is also completed. However, if a fax cannot 
be sent after redialing a specified number of times, only the storing of the data of the original is completed.
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 Specifying the network folder 
When you are authorized to specify a file destination for the network folder, specify the destination by setting the 
following items. The setting items differ depending on the file transfer protocol to be used. FTP, SMB, NetWare IPX/
SPX, NetWare TCP/IP and FTPS are selectable for a file transfer protocol.

Storing data in a network folder requires the administrator to set the equipment configuration. For details, refer to the 
TopAccess Guide.

If saving data in a network folder is enabled by the administrator, you can select 2 file destinations from [MFP Local], 
[Remote 1] and [Remote 2].

 FTP / FTPS

When you finish the entry, press [OK].

 Server Name: Enter the IP address of FTP server. For example, if the data should be transferred to an FTP folder 
“ftp://10.10.70.101/user01/scan/”, key in “10.10.70.101”.

 Network Path: Enter a network path to an FTP folder where the data are to be stored. For example, if the data 
should be transferred to an FTP folder “ftp://10.10.70.101/user01/scan/”, enter “user01\scan”.

 Login User Name: Enter a user name to login to the FTP server. Enter this as required.
 Password: Enter a password to login to the FTP server. Enter this as required.
 Command Port: Key in a command port number for executing commands. Normally “-” is entered in this field, 

which means that a port number set by the administrator will be used. Change this only when you want to use any 
other port number.
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 SMB

When you finish the entry, press [OK].

 Network Path: Enter a network path to the folder where the data are to be stored.
 Login User Name: Enter a user name to access the network folder. Enter this as required.
 Password: Enter a password to access the network folder. Enter this as required.

If you selected [SMB], the settings for [Server Name] and [Command Port] are not required.

 NetWareIPX / NetWareIP

When you finish the entry, press [OK].

 Server Name: When you select [NetWareIPX], enter either the server name of NetWare server or Tree/Context (if 
NDS is usable). When you select [NetWareIP], enter the IP address of NetWare server.

 Network Path: Enter a network path to a NetWare server folder where the data are to be stored. For example, if the 
data should be transferred to a folder “sys\scan” of NetWare server, enter “\sys\scan”.

 Login User Name: Enter a user name to login NetWare server. Enter this as required.
 Password: Enter a password to login NetWare server. Enter this as required.
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0.Printing Secure Receive fax jobs

When the PRINT DATA lamp on the control panel is lit, there is a received Secure Receive fax job. You can print the fax 
data by entering your Print Password.

This lamp does not light when the equipment is in the Super Sleep mode.

You can display the preview of the fax image received on the touch panel before printing the fax.
 P.48 “Displaying the preview of a received fax”

1 Press [Print] on the Home screen.
The print screen is displayed. If you leave the screen unattended for the auto clear setting time (45 sec. by 
default), the screen returns to the default one automatically.

2 Select [Secure Rx (Line 1)] or [Secure Rx (Line 2)]

If the equipment is running in the High Security mode, [Secure Rx (Line 1)] and [Secure Rx (Line 2)] are not 
displayed. [Secure Rx (Line 2)] is not displayed on some models.

3 Select the desired fax job and then press [Print].

You can select and print multiple fax jobs.

 When  is pressed, received fax jobs are displayed in the list.
To delete a received fax from the list, select the received file subject to delete and press [Delete].

 When  is pressed, received fax jobs are displayed in thumbnail images.
 To delete a received fax from the thumbnail, select the thumbnail image subject to delete and press [Delete].
 The entry of the password is required at the first operation of any of [Delete], [Print], [Display Image] or the 

thumbnail images.
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4 Enter the password for printing a received Secure Receive fax. Press [OK] to start printing.
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0.Printing Lists and Reports

 Printing Lists & Reports Manually
You can print lists and reports (journals) manually. For samples of lists and reports, see the following section.
 P.125 “PRINTING LISTS AND REPORTS”

 Lists and reports are printed on LT/A4-size paper. If this equipment has run out of LT/A4-size paper, lists and 
reports will be printed on larger sized paper.

 In addition to the lists described in this section, the following lists can be printed manually: For details of the 
operation, refer to the MFP Management Guide.
ADDRESS BOOK INFORMATION: List of recipients registered in the address book.
GROUP NUMBER INFORMATION: List of recipients registered in the address book as a group.
FUNCTION LIST: List of the user settings.

 Journal (transmission journal/reception journal)

You can print a list of transmissions and receptions.

This equipment logs up to the latest 40 or 120 transmission/reception records. This number can be set on the Admin 
menu. For details of the operation, refer to the MFP Management Guide.

1 Press [Job Status].

2 Select the [Log] tab, and then press [Send] or [Receive].
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3 Press [Journal].

If [Journal] is pressed with the transmission/reception records selected, the journal of the selected file is printed.

 Reservation list

You can print a list of the reserved transmissions.

1 Press [Job Status].

2 Press the [Fax], and then press [Reservation List].
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 Printing Lists & Reports Automatically
You can print lists and reports automatically. For samples of lists and reports, see the following section.
 P.125 “PRINTING LISTS AND REPORTS”

Lists and reports are automatically printed according to the settings that the administrator made, so no user 
operation is required. For details of the setting operation, refer to the MFP Management Guide.

The available lists/reports to be printed automatically are as follows:

TRANSMISSION JOURNAL
When this equipment completes 40 or 120 transmission jobs, the transmission journal is printed.

RECEPTION JOURNAL
When this equipment completes 40 or 120 reception jobs, the reception journal is printed.

MEMORY TRANSMISSION REPORT
When the memory transmission is completed, the report is printed. (You have an option to add a reduced image of the 
transmitted document.)

TRANSMISSION REPORT
When the direct transmission is completed, the report is printed.

MULTI TRANSMISSION REPORT
When the multi-address transmission is completed, the report is printed. (You have an option to add a reduced image 
of the transmitted document.)

MULTI POLLING REPORT
When a multi-polling Rx is completed, the report is printed.

RELAY TX ORIG. TERMINAL REPORT
When the document transmission from an originator terminal to a relay station is completed during the mailbox 
transmissions, the report is printed. (You have an option to add a reduced image of the transmitted document.)

RELAY TX RELAY STATION REPORT
When a document transmission from a relay station to an end terminal is completed during the mailbox 
transmissions, the report is printed. (You have an option to add a reduced image of the transmitted document.)

RELAY TX END TERMINAL REPORT
When the document transmission from a relay station to an end terminal is completed during the mailbox 
transmissions, the report is sent to an originator terminal. (You have an option to add a reduced image of the 
transmitted document.)

RELAY STATION REPORT
When a relay station in this equipment receives an original during the mailbox transmissions, the report is printed.

MAILBOX RECEPTION REPORT
When the confidential or bulletin board mailbox in this equipment receives an original during the mailbox receptions, 
the report is printed.
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0.Overview of the Network Fax Features

This equipment provides the network fax features, which simplify and facilitate your office facsimile needs and 
enables you to send fax or Internet Fax digital documents directly from your desktop.

 Fax transmission using the N/W-Fax driver is available only when the FAX unit is installed.
 Please enable the SNMP setting on TopAccess to use the N/W-Fax functions. In addition, the N/W-Fax driver does 

not work if the SNMP setting on TopAccess is disabled when the optional FAX unit is installed.

The N/W-Fax driver and the AddressBook Viewer are the network fax utilities which are the client software of this 
equipment.

The highly intuitive, N/W-Fax driver enables you to select the fax printer driver to electronically fax or Internet Fax 
from your computer to one or more recipients. By the combination with the AddressBook Viewer, you can easily 
manage a selection of fax recipients and access to the address book.

The N/W-Fax driver enables you to set up send lists and send electronic documents from your computer to one or 
more destinations. You send to the fax in much the same way you would choose to print to a designated printer that 
makes using the N/W-Fax driver quick and simple. You can select the fax properties. Fax properties are the attributes 
you can set to define sender and recipient information for processing fax jobs such as dialing options, sender 
information, fax resolution and page layout.
Other features include an easy-to-use fax scheduler that allows you to set up a date and time to transmit your fax. 
Cover page options are also provided. You can include a customized cover page with your fax transmission that can 
contain sender and recipient fax information and a detailed message. You can easily maintain sender and contact 
information that can be printed on the cover pages.

Faxing paper documents must be performed by using the fax function from the touch panel of the MFP.

 The image quality of the originals that are sent by the N/W-Fax driver is different from the originals that are sent by 
the general fax operation.

 If you specify the Email addresses as the recipients using the N/W-Fax driver, the document will be sent as an 
Internet Fax. The Internet Fax feature allows users to send originals the same as the fax features. However, an 
Internet Fax is sent through the Internet, although a fax is sent through the public switched telephone line. In order 
to send an Internet Fax, the remote device also must support the Internet Fax feature.
For more details about the Internet Fax, see the following sections.
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0.Sending Network Faxes

The basic procedure for sending a fax (Network Fax / Internet Fax) is as follows.
You can use standard functions or set optional functions as well as the basic ones described in this section. For these 
operations, see the following section.
 P.100 “Setting up the N/W-Fax Driver”

1 Start the application software and prepare the document to be sent.

2 Select [Print] from the [File] menu in the application software.

The procedure for displaying the [Print] dialog box may differ from the above depending on the application 
software.

3 Select [TOSHIBA e-STUDIO Fax] for the printer and click [Preferences].

The dialog box of the N/W-Fax driver properties appears.

Note that the command name to open the driver properties may differ from [Preferences] depending on the 
application software.

4 Click the [Send] tab and specify the recipients.
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 To specify recipients, enter them with the keyboard or select them from the address book.
 P.92 “Specifying Recipients of Network Faxes”

 On the [Send] tab, you can set the resolution of a fax cover sheet, etc. as well as specifying the recipients.
 P.102 “Setting up the [Send] tab”

 On the [Layout] tab, you can set the size and the orientation of the paper.
 P.101 “Setting up the [Layout] tab”

5 Confirm the recipients and click [OK].
The transmission settings are determined and the N/W-Fax driver properties dialog box is closed.

6 Click [Print] in the [Print] dialog box.

A fax is sent.

 Note that the command name to print a document (send a fax) may differ from [Print] depending on the 
application software.

 A waiting fax job can be checked or deleted through the managing jobs function in TopAccess. A sent fax job 
can also be checked through the displaying job logs function in TopAccess. For details, refer to the TopAccess 
Guide.

When password entry is required
When the [Enter the user credentials manually] option is enabled on this equipment, you are prompted to enter your 
user name and password before sending a fax.
When the dialog box appears, enter your user name and password, and then click [OK].

 Up to 128 characters can be entered in the [User Name] box. Up to 64 characters in the [Password] box.
 The user name and password entered in the above boxes are not stored. Therefore, you must enter your user name 

and password every time you send a fax.
 If you want to change the settings of this option, carry it out on the [Device Settings] tab.
 P.108 “Setting up the [Device Settings] tab”
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When LDAP authentication is enabled
When LDAP authentication is enabled on this equipment, you must specify an LDAP server in the [Server Name] box on 
the [Send] tab before sending a fax.

If you attempt to send a fax without specifying an LDAP server, the [Specify LDAP Server] dialog box will appear to ask 
you to do so.

In this case, specify the desired LDAP server in the [Server Name] box and click [OK] to send the fax.

If you want to change the settings of an LDAP authentication, carry it out on the [Device Settings] tab.
 P.108 “Setting up the [Device Settings] tab”
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0.Specifying Recipients of Network Faxes

Up to 400 recipients can be specified in a single operation.
To send a Network Fax, specify the fax number. To send an Internet Fax, specify the Email address.
 P.92 “Entering recipients from the keyboard”
 P.94 “Selecting recipients from the address book”
 P.95 “Selecting recipients from the address book (Search option)”
 P.99 “Removing recipients”

If more than one recipient is specified in a single transmission, and a cover sheet is set in the N/W-Fax driver or a 
header page is set to be printed on the recipient’s device, all the recipient information may be printed. If you want to 
secure the recipient information, avoid sending a fax to multiple recipients at the same time.

To use the address book, you need to register recipients in the address book of AddressBook Viewer in advance.

 Entering recipients from the keyboard
You can enter a recipient with the keyboard.

1 Select the entry method of a recipient to enter its fax number or Email address.
 For the recipient of a Network Fax, select the [Fax Number] check box and enter the fax number in the right-

hand box. 

 For the recipient of an Internet Fax, select the [Internet Fax Address] check box and enter the Email address in 
the right-hand box.
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 Use “ - ” (hyphen) if you send a Network Fax with pauses (approx. 3 seconds) inserted in the fax number.
 When you enter a fax number, you can also enter a sub address and a password. Click [SUB/PWD] to enter 

them (within 20 digits each) in the dialog box. Entering them enables the document to be transferred from the 
recipient’s device to that of the sub-address, as the communication is in compliance with ITU-T standard. 
However, in order to use this function, the recipient’s device must be a model in compliance with the ITU-T 
standard.

2 Click .

The recipients selected for “To” are listed. 
To send faxes to several recipients, repeat steps 1 and 2 to add the necessary fax numbers or Email addresses to 
the list.

When the fax transmission is completed, the recipients are automatically removed from the “To” list.
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 Selecting recipients from the address book
Select recipients from the address book in the AddressBook Viewer.

1 Click [Address Book].

The AddressBook Viewer runs.

2 Select a recipient from the contact list and add it to the list below.
 When selecting the recipient with the fax number, click [Select Fax].

 When selecting the recipient with the Email address, click [Select Email].

The selected recipients are listed in the “Selected Contacts”.
To send faxes to several recipients, repeat the above steps to add the necessary fax numbers or E-mail addresses 
to the lists.

A contact, for which only a fax number is registered, cannot be displayed in the “Email Address” and a contact, for 
which only an Email address is registered, cannot be displayed in the “Fax Number”.
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You can select a recipient by the following operations:

 Selecting a contact by dragging and dropping
Drag a contact in the contact list and drop it to [Selected Contacts] and then select [Fax Number] or [Email 
Address] from [Select].

 Selecting a contact by double-clicking on it
Double-click on a contact in the contact list. Since [Email] is set as the factory default, only the Email address 
of the recipient selected by double-clicking on a contact is displayed in “Selected Contacts”. To change the 
setting of the recipient to be selected upon double-clicking, select [Default Configuration], [Type Selection] in 
the [View] menu and then one of [Fax], [Email] and [Both].

 Selecting a contact from a shortcut menu
Right-click on the contact in the contact list, select [Select] from the shortcut menu and then either [Fax 
Number] and [Email].

 Removing a recipient
Select a recipient in the “Selected Contacts” and click [Remove].

3 Confirm the recipients and click [OK].
The AddressBook Viewer is closed and the recipients selected for “To” are listed.

When the fax transmission is completed, the recipients are automatically removed from the “To” list.

 Selecting recipients from the address book (Search option)
You can find and select a recipient from the address book in the AddressBook Viewer.

1 Click [Address Book].

The AddressBook Viewer runs.
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2 Click the [Find] menu.

The [Find Contact] dialog box appears.

3 Select an address book in [Data Source].

To change the setting of the default address book in the [Data Source] box, select [View] - [Default Configuration] 
- [Data Source] and then choose an address book.
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4 Display the [Person] tab and enter search strings in the following boxes.

 Display Name — To search display names, enter a search string here.

 Fax Number — To search fax numbers, enter the numbers here.

 Email — To search Email addresses, enter a search string here.

If you perform searching in the above conditions, proceed to step 6. If you want to set more detailed search 
conditions, proceed to step 5 and set them in the [Detail Setting] tab. However, note that even if you enter the 
search conditions in both the [Person] and [Detail Setting] tabs, you cannot perform searching in this 
combination at one time.

In the [Person] tab, you do not have to fill in all the boxes and the string does not need to completely correspond 
to the target of the search. Entering one or more characters in one or more boxes causes a search to be made for 
contacts which correspond to the particular conditions.

5 Display the [Detail Setting] tab, set the search conditions, and then click [Add].
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 Field Select — Select an item to be searched.

 Condition of search string — Select a condition in the left-hand box, and then enter a search string in the 
right-hand box.

The search condition is displayed in the “Condition list”.
To set more than one search condition, repeat this operation as many times as needed.
To delete the search conditions, select one and click [Remove].

6 Click [Search].

It starts searching contacts in the selected address book. When the search is complete, the contacts matching the 
search conditions are listed.
To stop searching, click [Stop].

Even if you enter the search conditions in both the [Person] and [Detail Setting] tabs, only the search conditions 
in the tab currently displayed is used. You cannot perform searching in the combined conditions on both tabs.

7 Drag and drop the contacts to “Selected Contacts” from the list of the search results.
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8 Select of [Fax Number] or [Email Address] from [Select].
The selected recipients are listed in “Selected Contacts”.
To send faxes to several recipients, repeat steps 1 through 8 to add the necessary fax numbers or Email addresses 
to the list.

A contact, for which only a fax number is registered, cannot be displayed in the “Email Address” and a contact, for 
which only an Email address is registered, cannot be displayed in the “Fax Number”.

You can select a recipient by the following operations:

 Selecting a contact by double-clicking on it
Double-click on a contact in the list of the search results. Since [Email] is set as the factory default, only the 
Email address of the recipient selected by double-clicking on a contact is displayed in “Selected Contacts”. To 
change the setting of the recipient to be selected upon double-clicking, select [Default Configuration], [Type 
Selection] in the [View] menu and then one of [Fax], [Email] and [Both].

 Selecting a contact from a shortcut menu
Right-click on the contact in the list of the search results, select [Select] from the shortcut menu and then 
select either [Fax Number] or [Email].

 Removing a recipient
Select a recipient in the “Selected Contacts” and click [Remove].

9 Confirm the recipients and click [OK].
The AddressBook Viewer is closed and the recipients selected for “To” are displayed on the list.

When the fax transmission is completed, the recipients are automatically removed from the “To” list.

 Removing recipients
You can remove a recipient from the “To” list in the N/W-Fax driver properties.

1 Select a recipient and click [Remove].

The selected recipient is removed.
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0.Setting up the N/W-Fax Driver

There are two ways to set the N/W-Fax driver options: One is to make the initial settings of the options and the other is 
to set each option for each individual job.
 P.100 “Making the initial settings of the N/W-Fax driver options”
 P.100 “Setting print options for each print job”

Making the initial settings of the N/W-Fax driver options
Setting the N/W-Fax options by displaying the N/W-Fax driver properties from the Printers folder on the Windows 
[Start] menu will establish the initial settings of the options.

1 Click [Start] and select [Settings] > [Devices] > [Devices and printers].
When using Windows 8.1 or Windows Server 2012, right-click in the lower left of the screen, then click [Control 
Panel] > [Devices and Printers].

2 Right-click [TOSHIBA e-STUDIO Fax], and then select [Printing preferences] or [Printer 
properties] from a shortcut menu.
If [File] menu is not displayed, press [Alt].

 Setting print options for each print job
Setting the N/W-Fax driver options by displaying the printer properties from the [Print] dialog box within an 
application will establish the settings for the current N/W-Fax job. The N/W-Fax driver option settings specific to each 
N/W-Fax job are set using this method.

1 Click the [File] menu and select [Print] on an application.

2 Select [TOSHIBA e-STUDIO Fax] and click [Properties] or [Preferences].
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0.Setting up the N/W-Fax Driver Options

You can make the settings for the N/W-Fax driver options. For example, you can specify the recipients, resolution, and 
paper size.
 P.101 “Setting up the [Layout] tab”
 P.102 “Setting up the [Send] tab”
 P.104 “Setting up the Cover Sheet”
 P.106 “Setting up the SNMP”
 P.108 “Setting up the [Device Settings] tab”
 P.109 “Customization: [Language] tab”
 P.110 “Setting up LDAP servers”

 Setting up the [Layout] tab
On the [Layout] tab, you can set the size and the orientation of the paper. 

1. Orientation
Set the printing orientation of the document.

- Portrait — Data are printed vertically to the paper.
- Landscape — Data are printed horizontally to the paper.

2. [Advanced]
Click this to display the [Advanced Option] dialog box. You can select the paper size of the document.

2

1
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 Setting up the [Send] tab
In the [Send] tab, you can specify the recipients and how the fax will be sent.

1. [Address Book]
Click to launch the AddressBook Viewer. You can select recipients from the address book.
 P.94 “Selecting recipients from the address book”

2. To
This displays the specified recipients list.
 P.92 “Specifying Recipients of Network Faxes”

3. [Remove]
Select a recipient in the [To] list and click this to remove the recipient from the list.
 P.99 “Removing recipients”

4. Fax Number
Enter the recipient’s fax number directly. 
 P.92 “Entering recipients from the keyboard”

5. [SUB/PWD]
Click this to display the [SUB/PWD] dialog box. You can add a sub address and a password to the entered fax 
number.
 P.92 “Entering recipients from the keyboard”

6. Internet Fax Address
Enter the recipient’s Internet Fax number directly. 
 P.92 “Entering recipients from the keyboard”

7. Resolution
Select the resolution for the fax.

- Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x 100 dpi).
- Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).
- Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200 x 400 dpi).
- Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x 400 dpi).

8. Department Code
Enter a department code of 1 to 63 characters if required. When the department code is enabled on the MFP, you 
must enter it to send a fax.

5
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 If you do not enter a department code when it is enabled on the MFP the [Invalid Department Code Print Job] 
is set to “Store to invalid job list” in TopAccess, the job will be stored in the Invalid job list without being 
transmitted. You can print or delete a stored job from the [Job Status] on the touch panel.

 If you do not enter the department code when the department code is enabled on the MFP and the [Invalid 
Department Code Print Job] is set to PRINT in TopAccess, the job will be sent.

 If you do not enter the department code when the department code is enabled on the MFP and the [Invalid 
Department Code Print Job] is set to DELETE in TopAccess, the job will be deleted automatically.

9. Hide Department Code
Select this check box to display a department code in the hidden symbols.

10. Cover Sheet
Select a cover sheet type among [Standard Cover Page], [Business Cover Page], [Professional Cover Page] and 
[My Cover Page] if you want to attach a cover sheet to the first page of the document.
 P.113 “Sending with a cover sheet”

11. [Edit]
Click this to display the [Cover Sheet Settings] dialog box. You can perform various kinds of editing on the cover 
sheet selected in the Cover Sheet setting, such as entering a subject or a message, or changing the type or size of 
the fonts. 
 P.104 “Setting up the Cover Sheet”

12. Server Name
Select the desired LDAP server in the [Server Name] box if needed.

You can make settings for the LDAP server on the [Device Settings] tab.
 P.108 “Setting up the [Device Settings] tab”

13. [SNMP Settings]
Click this to check or change the SNMP settings.
 P.106 “Setting up the SNMP”

14. Delayed Fax
Select this to send a document at a specified date and time. When this is selected, click [Edit] to display the 
[Scheduled Time] dialog box and specify date and time the job will be transmitted. The job sent to the MFP will be 
stored in the Fax queue until the specified date and time.
 P.112 “Delayed transmission reservation”

15. Save as File
Select this to save up to 10 GB of documents in the “file_share” folder in the MFP as well as send the document as 
a fax and Internet Fax.
 P.111 “Saving a fax as a file”

When the cover sheet is set, the cover sheet and the original will be stored in the “file_share” folder.

16. File Format
Select the file format of the document that will be saved. This option can be selected only when the [Save as File] 
check box is selected.

17. OCR
Select this check box to enable the OCR function. This option can be selected only when the [Save as File] check 
box is selected. The OCR option is necessary to use the OCR function.

18. [Restore Defaults]
Click this to restore the settings to make the equipment as it was at the time of factory shipment.

19. [Help]
Click this to browse Help for the N/W-Fax driver.
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 Setting up the Cover Sheet
You can set the content of the cover sheet to be attached to a fax.
 P.113 “Sending with a cover sheet”

Emoji is not available for a cover sheet.

1. Preview
The image of the cover sheet can be previewed. You can check the layout of the character strings and images.

 Depending on the line feed positions, the preview may not duplicate the actual print result of the cover sheet, 
but is used for checking its layout.

 If the contents are on more than one page, such as the many line feeds included in “Sender Information” or 
“Message”, only the first one page is displayed in the preview.

2. [Simple Format]/[Detail Format] switch button
Switch the display format for the description of the sending information on the cover sheet. By selecting [Detail 
Format], ruled lines appear. By selecting [Simple Format], no ruled lines appear.
[Simple Format] is set as the default. [Detail Format] is displayed on the button.

3. [Large Preview]
Click this to display the cover sheet on another screen. You can enlarge the preview or display another page when 
there are multiple pages.

4. Fonts
Select the font to be used for the cover sheet. Select the section for which the font is used, and then click [Edit] to 
select the type, style and size of the font. 

- Header — Set the font to be used for the header of the cover sheet.
- Title — Set the font to be used for the title such as Reference Number, Recipients Information, Sender 

Information, Subject or Message.
- Body — Set the font to be used for the body of each title.
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5. Footer
Select an image file to be attached to the footer of the cover sheet.

- [Browse] — Click this to select an image file to be attached to the footer within 1 MB.
- [Delete] — Click this to delete the attached image file. 
- Position — Select the position of the image file from the left, center and right. 

6. Header Text
Enter a title to be displayed on the header of the cover sheet; it can be up to 63 characters. 

7. Reference Number
Check this to have a reference number identifying the fax to appear on the cover sheet. Enter the reference 
number in the text box. 

8. Recipient’s Information
Check this to have the recipient’s information appear on the cover sheet. Select the desired information among 
the options below. 

- Name — Check this to have the recipient name appear on the cover sheet.
- Company — Check this to have the recipient company name appear on the cover sheet.
- Department Name — Check this to have the recipient department name appear on the cover sheet.
- Fax Number — Check this to have the recipient fax number or Email address appear on the cover sheet.

9. Sender Information
Check this to have the sender’s information appear on the cover sheet. You can enter the information in up to 500 
characters. 

10. Subject
Check this to have a subject appear on the cover sheet. You can enter the subject in up to 40 characters.

11. Message
Check this to have a message appear on the cover sheet. You can enter the message in up to 500 characters. 

12. [Restore Defaults]
Click this to restore the settings to make the equipment as it was at the time of factory shipment.
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 Setting up the SNMP
If the recipient’s MFP is not found over the Internet and the fax job is not sent normally, the SNMP settings may be the 
cause. Check that the SNMP settings are correct in the [SNMP Settings] dialog box, and if not, change them.

Ask the administrator for details on the SNMP Network settings configured for your MFP.

1. Version
Be sure to have the correct SNMP version set for your MFP and select from the following options:

- V1/V2 — Select this option to enable SNMP V1 and V2.
- V3 — Select this option to enable SNMP V3.
- V1/V2/V3 (for [Discovery Settings] dialog box only) — Select this option to enable SNMP V1, V2, and V3.

2. SNMP V1/V2
Community Name — If a community name other than “private” (default) is set for the SNMP community name 
for your MFP, enter its community name.

 To send fax jobs normally under an SNMP V1/V2 environment, the SNMP community names must be the same 
in the 3 settings shown below. For details, ask your administrator.

- Your MFP
- [SNMP Settings] dialog box of the [Send] tab

1

2

3

4
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- [Port Settings] tab in the N/W-Fax driver

 To change the community name, the administrator privilege is necessary. You must log in with the 
“Administrator” privilege and open the printer driver properties.

 Up to 31 characters including the following symbols can be entered for the Community Name.
! " # $ % & ' ( ) * + , - / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

3. SNMP V3
If SNMP V3 is enabled, select one of the following items to set how users are authenticated.
User ID File — Select this option when you want to use a user ID file. Click [Browse] and specify the user ID file.
User Name/Password — Select this option when you want to use the user name and password. When this option 
is selected, enter or select the following items:

- User Name
- Authentication Protocol
- Authentication Password
- Privacy Protocol
- Privacy Password

 If you select to enable SNMP V3, consult your network administrator for preliminary advice on how to 
authenticate users.

 Up to 31 characters including the following symbols can be entered for each of the User Name, Authentication 
Password and Privacy Password.
! $ % & ' ( ) - , < > @ [ ] ^ _ ` { } ~

 This function is not available when your computer and MFP are connected with a USB cable.

4. [Restore Default]
Click this to restore the settings to make the equipment as it was at the time of factory shipment.
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 Setting up the [Device Settings] tab
On the [Device Settings] tab, you can change a setting for N/W-Fax driver update or display the software version of the 
driver. 

Ask the administrator for details on the settings configured for your MFP.

1. Update Automatically
Select whether or not the setting information of each item on the [Device Settings] tab of the N/W-Fax driver is to 
be obtained by automatically communicating with your MFP every time this tab is opened.

- On — Select this to obtain the setting information automatically.
- Off — Select this not to obtain the setting information automatically. Set each item manually.

This function is not available when your computer and MFP are connected with a USB cable.

2. User Authentication
Select the authentication method which is to be used. Set it to correspond to that of your MFP.

- Off — Select this not to perform user authentication. 
- MFP Local Authentication — Select this to perform MFP Local Authentication.
- Windows Domain Authentication — Select this to perform Windows Domain Authentication.
- LDAP Authentication — Select this to perform LDAP Authentication.

If the user authentication and project code are enabled in the equipment, you need to enter the project code 
when sending the fax.

3. [Details]
The [LDAP Server Settings] dialog box will appear. This option can be selected only when [LDAP Authentication] 
is selected in the [User Authentication] box.
 P.110 “Setting up LDAP servers”

4. Enter the user credentials manually
When this check box is selected, you are prompted to enter your user name and password every time you send a 
fax. This option is available when any of MFP Local Authentication, Windows Domain Authentication, or LDAP 
Authentication is selected in the [User Authentication] box.

 To configure this option, select [Off] in the [Update Automatically] box.
 This option can be used together with any of the user authentication functions (MFP Local Authentication, 

Windows Domain Authentication, LDAP Authentication).

1
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5. Fax Function
Select whether or not the fax function is enabled. Set it to correspond to that of your MFP.

- Enabled — Select this to enable the fax function. 
- Disabled — Select this to disable the fax function.

6. Internet Fax Function
Select whether or not the Internet Fax function is enabled. Set it to correspond to that of your MFP.

- Enabled — Select this to enable the Internet Fax function. 
- Disabled — Select this to disable the Internet Fax function. 

7. IP-Fax Function
Select whether or not the IP Fax function is enabled. Set it to correspond to that of your MFP.

- Enabled — Select this to enable the IP Fax function.
- Disabled — Select this to disable the IP Fax function.

8. Cover Sheet confirmation
Select whether or not to display a message indicating a precaution that a cover sheet is being selected when a fax 
job is sent.

- Enable — Select this to display the message.
- Disable — Select this not to display the message.

9. Customization
The [Customization] dialog box is displayed.
 P.109 “Customization: [Language] tab”

10. [Version Information]
Click this to display the software version information of the N/W-Fax driver. 

 Customization: [Language] tab
You can switch N/W-Fax driver language.

1. Language
This selects the language to be used.

- Auto / Chinese (Simplified, China) / Danish (Denmark) / Dutch (Netherlands) / English (United States) / Finnish 
(Finland) / German (Germany) / Italian (Italy) / Spanish (Spain, Traditional Sort) / French (France) / Norwegian 
Bokmål (Norway) / Russian (Russia) / Chinese (Traditional, Taiwan) / Turkish (Turkey) / Japanese (Japan) / 
Polish (Poland) / Swedish (Sweden) / Portuguese (Brazil)

[Auto] is selected by default. When [Auto] is selected, the most appropriate printer driver language is 
automatically set according to the regional and language settings in Windows OS.

2. [Restore Defaults]
Click this to restore the factory defaults on the [Language] tab.

1

2
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 Setting up LDAP servers
The [LDAP Server Settings] dialog box allows you to register LDAP servers.

1. [Update Now]
Click this to obtain LDAP server information automatically from your MFP, and register it in [Server Name List].

This function is not available when your computer and MFP are connected with a USB cable.

2. Server Name
Enter the desired LDAP server in this box if needed.

Up to 64 characters (excluding # ; \ =) can be entered for the [Server Name] box.

3. [Add]
Click this button to register the LDAP server in the [Server Name List], which has been entered in the [Server 
Name] box.

4. Server Name List
The registered LDAP servers are displayed in this list. Up to 16 LDAP servers can be registered.

5. [Delete]
Click this button to delete an LDAP server in [Server Name List]. Select the LDAP server that you want to delete in 
the list, and click this button.

1
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0.Sending With Extended Fax Functionality

The N/W-Fax driver allows users to perform the following features.
 P.111 “Saving a fax as a file”
 P.112 “Delayed transmission reservation”
 P.113 “Sending with a cover sheet”

 Saving a fax as a file
You can save a document in the “TXFAX” folder in the “file_share” folder in the MFP as well as sending the document 
to fax numbers and Email addresses.

1 Display the [Send] tab and select the [Save as File] check box.

2 Select the file format in the [File Format] box.

3 Specify the other options to send a document and click [OK].

4 Click [OK] (or [Print]) to send a document to the MFP.
The document is saved in the “TXFAX” folder in the “file_share” folder in the MFP.

 The saved file contains the cover sheet when the cover sheet is set.
 Since the image smoothing function does not work for the image stored in the “file_share” folder, its printing 

image quality differs from the normal fax image quality.
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 Delayed transmission reservation
When the delayed transmission is specified, the fax is stored in the fax queue in the MFP and will be sent at the 
specified date and time.

1 Display the [Send] tab and select the [Delayed Fax] check box.

2 Click [Edit].
The [Scheduled Time] dialog box appears.

3 Select the date and time and click [OK].

 You can click the arrow in the Date box to display a calendar that allows you to select a date.

 Enter the time to start the fax transmission. You can use the up and down arrows.

4 Specify the other options to send a document and click [OK].

5 Click [OK] (or [Print]) to send a document to this equipment.
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 Sending with a cover sheet
You can choose to send a cover sheet with your fax transmission. You can select what to include on the cover sheet 
such as sender or recipient information.

 When a printer driver whose name consists of 54 letters or more is specified for the default printer and an attempt 
is made to send a fax with a cover sheet added from Microsoft Excel using a N/W-Fax driver with an IPP port, an XL 
error may occur and fax transmission may be impossible. (This error does not occur in application software other 
than Microsoft Excel.)
If this error occurs, perform one of the following and start sending a fax again.

- Use 30 letters or less for the N/W Fax driver name.
- Do not attach any cover sheet.

 Emoji is not available for a cover sheet.

1 Display the [Send] tab, select the cover sheet type in the [Cover Sheet] box and then click [Edit]. 

The [Cover Sheet Settings] dialog box appears.
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2 Enter the title of the cover sheet in the [Header Text] box.

You can enter up to 63 characters for the header text.

3 If you want a reference number identifying the document to appear on the cover sheet, select the 
[Reference Number] check box and then enter the reference number in the text box.

You can enter up to 20 characters for the reference number.

4 If you want the recipient’s information to appear on the cover sheet, select the [Recipient 
Information] check box and then select the options required for the recipient information.

Name — Check this to have the name of the recipient appear on the cover sheet.
Company — Check this to have the company name of the recipient appear on the cover sheet.
Department Name — Check this to have the department name of the recipient appear on the cover sheet.
Fax Number — Check this to have the fax number or Email address of the recipient appear on the cover sheet.
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 Recipient information is obtained from the address book. If the recipient is added manually, this information 
does not appear on the cover sheet except for the fax number or Email address.

 The recipient information for all recipients will appear on the cover sheet.

5 If you want sender information to appear on the cover sheet, select the [Sender Information] 
check box and then enter the sender information in the text box.

You can enter up to 500 characters for the sender information.

6 If you want a subject to appear on the cover sheet, select the [Subject] check box and then enter 
the subject in the text box.

You can enter up to 40 characters for the subject.

7 If you want a message to appear on the cover sheet, select the [Message] check box and then 
enter the message in the text box.

You can enter up to 500 characters for the message.
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8 If you want to change the font of the characters on the cover sheet, select the corresponding 
section in the [Font for] box, and then click [Edit]. 

The [Font] dialog box appears.

If you do not change the font, proceed to step 10. 

9 Select the desired one from each of the [Font], [Font style], [Size] and [Script] boxes, and then 
click [OK].

The [Font] dialog box is closed and the font settings are determined for the selected section. 

If you want to change the font of other sections, repeat the procedure from step 8.

10If you want to attach an image file on the footer, click [Browse] of Image File.

The [Open] dialog box appears.

If you do not attach an image file, proceed to step 13.
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11Select an image file to be attached and then click [Open].

The [Open] dialog box is closed and the selected image file is attached.

Attach the image file in a bitmap format (.bmp) within 1 MB.

12Select the position of the image file.

- : Select this to align the image to the left.

- : Select this to align the image to the center.

- : Select this to align the image to the right.

13Specify the other options to send a document and click [OK].

14Click [Print] to send a document to the MFP.



4.USING N/W-FAX DRIVER (NETWORK FAX)

118    Sending With Extended Fax Functionality



5.USING THE INTERNET FAX

This chapter describes the Internet Fax feature.

Internet Fax Features ..................................................................................................... 120

Precautions for Internet Fax Transmissions...................................................................... 121

Sending Internet Faxes ................................................................................................... 122
Sending Internet faxes.......................................................................................................................................122
Setting advanced functions ..............................................................................................................................123
Saving data sent in a file along with internet fax transmission.......................................................................123

Receiving Internet Faxes................................................................................................. 124
Available file formats .........................................................................................................................................124
Receiving Internet faxes ....................................................................................................................................124



120    Internet Fax Features

0.Internet Fax Features

Internet Fax allows a copy of a scanned document to be sent as an E-mail with an attached TIFF-FX (Profile S) file. 
Since an Internet line is used instead of a phone line, the communication costs can be dramatically reduced.
With Internet Fax, an E-mail address is to be specified in place of a phone number to transmit a copy of a scanned 
document to the Internet Fax equipment or the client computers.
When an Internet Fax is received, it is automatically output just like a traditional fax.

Internet faxing requires the network settings configured by the network administrator. Consult your network 
administrator for help.

With Internet Fax, you can perform various transmissions as illustrated below.

 Internet Fax Equipment to Internet Fax Equipment
The equipment can send a copy of a document to other Internet Fax equipment via Internet or Intranet. The copy of 
the document is sent as an E-mail.

 Internet Fax Machine to/from Client Computers
The equipment can send a copy of a document as an E-mail to client computers via Internet or Intranet. The client 
computers can send an E-mail to the equipment as well.

 When the equipment sends a copy of a document using Internet Fax, the client computer receives the copy as TIFF-
FX (Profile S) images.

 The MFP can print out only text files and image files in TIFF format; from the client computer, you cannot send files 
other than text or TIFF images to the MFP. For available formats, see the following section:
 P.124 “Available file formats”

E-mail transmission
LAN

Mail serverMail server

Internet
Intranet

E-mail transmission
LAN

Mail server Mail serverClient computer Client computer

Internet
Intranet
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0.Precautions for Internet Fax Transmissions

Internet Fax works just like e-mail and may cause the same kinds of troubles as E-mail unless you understand how it 
works. Before you start using the Internet Fax feature, carefully read and familiarize yourself with the following 
precautions:

 Internet Fax sends a copy of a document to your E-mail server, not via the PSTN* as with a traditional fax. The data 
is then sent from the server to the Internet. Unlike traditional faxing, Internet faxing does not involve a direct 
communication with the recipient(s). Transmission is considered complete when the sent copy of the document 
reaches your E-mail server.

 The security level of Internet transmissions is low. We recommend traditional faxing when sending confidential 
documents.

  Due to heavy line traffic, Internet transmissions may take a while to arrive.
 The configuration of the E-mail server may prevent successful transmission if the data size of the sent document 

exceeds set limits.
 When you send an Internet fax to multiple recipients, all the recipients’ E-mail addresses are printed if the header 

page is set to be printed on the recipients devices. If you need to secure the personal information, send the Internet 
fax separately to each recipient rather than sending to multiple recipients at the same time.

* PSTN (Public Switched Telephone Network) is a global telephone system capable of communicating worldwide using copper wires to transmit 
analog data.
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0.Sending Internet Faxes

Just like the Scan to E-mail function, Internet Fax sends scanned data to specified E-mail addresses as an attached 
file. The difference is the format of the file; it is TIFF-FX (Profile S), which can be received and printed on Internet Fax 
devices. With a few additional steps, you can also save the sent data or set advanced functions for each transmission.

 P.122 “Sending Internet faxes”
 P.123 “Saving data sent in a file along with internet fax transmission”
 P.123 “Setting advanced functions”

To use the Internet Fax feature, the network administrator must set the equipment configuration.

 Sending Internet faxes

1 Place the original(s).
 P.22 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.
 Original Size

Press the corresponding button for the original size. To have the equipment automatically set the original size, 
press [Auto].
When using originals of various paper widths, press [Different Width].
 P.29 “Setting the original size”

 Resolution
Select the resolution for scanning the original.
 P.30 “Setting the resolution”

For the setting items related to the internet fax which should be set as other transmission conditions, see the 
following section.
 P.31 “Setting other transmission conditions”

 Exposure
Select the appropriate exposure for scanning the original. Pressing [Auto] automatically sets the exposure 

best suited to your originals. To set the exposure manually, use  or  to select the appropriate exposure.

 Original Mode
Select an original mode to scan the original for the best image quality.

- [Text/Photo] — Press this button to scan an original consisting of both text and photos.

- [Text] — Press this button to scan an original consisting of text.

- [Photo] — Press this button to scan an original containing photo images printed on photographic paper.

 2-Sided Scan
Select the type (1-sided or 2-sided) of the original to be scanned
Single: Press this button to scan a 1-sided original.
Book: Press this button to scan a 2-sided right-to-left (book-type) original.
Tablet: Press this button to scan a 2-sided top-to-bottom (tablet-type) original.

 Tx Type
When sending an Internet Fax, you can only select [Memory Tx]. 
 P.31 “Setting other transmission conditions”

 [Subject]
Enter the subject of the Internet Fax to be sent.

 [Body]
Enter the body message of the Internet Fax to be sent.
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 All the settings required for Internet faxing are mentioned in the above steps. Settings other than the above 
apply only to fax transmissions.

 When sending an Internet Fax, [Fine] is always applied even if you select [U-Fine] in Resolution.
 Internet faxing sends copies of A4, LT or LG size originals in the same size as the originals’. Originals larger than 

A4, LT, or LG are reduced to A4 or LT, whereas originals smaller than these sizes are sent as A4 or LT without 
being enlarged.

 When either [Text/Photo] or [Photo] is selected in Original Mode, the transmission may take a while.
 The administrator can change the body message from TopAccess. For details, refer to the TopAccess Guide.

4 Specify the E-mail address of the recipient.
 P.35 “Specifying the recipient”

You can save the sent data as a file.
 P.122 “Sending Internet Faxes”

5 Press [Send].
 P.27 “Sending a Fax”

 Setting advanced functions
The following advanced functions can be set during an Internet faxing operation. The setting method for these 
functions is the same as that for those of the general fax sending operation. For details, see the following page.

 Priority Reserve — Use this function when you want to send originals ahead of the currently reserved 
transmissions.
 P.59 “Communicating to a Request from a Recipient (Polling Communication)”

 Saving data sent in a file along with internet fax transmission
When sending an Internet fax, you can also save the sent data in the equipment’s shared folder and/or a network 
folder (Remote 1 or 2).

 To save the data in a network folder, the administrator needs to set the equipment configuration. For details, refer 
to the TopAccess Guide.

 Internet Fax and File is not available when the forced encryption setting is enabled. To learn more about the forced 
encryption setting, refer to the MFP Management Guide.
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0.Receiving Internet Faxes

 Available file formats
The equipment can print out TIFF-FX images, TIFF images scanned in black and white, and text data (email messages 
in the plain text format). In addition, the resolution of the TIFF-FX images must be either 8 x 3.85 or 8 x 7.7 or 8 x 15.4 
(dot/mm) while that of scanned TIFF images must be 200 x 100, 200 x 200, 200 x 400, 400 x 400, or 600 x 600 (dpi).

If any files failing to meet the above conditions are attached to a received Internet Fax, an E-mail printing error occurs 
and is recorded as an error code on the Receive log. On TopAccess, the “Email Print” settings are available for the 
administrator so that error codes can be printed as a report. The administrator can also set the equipment to forward 
such Internet Faxes to another E-mail address. For details, refer to the TopAccess Guide.

 Receiving Internet faxes
The equipment accesses the E-mail server at specified intervals to check whether any E-mail has been delivered. New 
E-mail is automatically received and printed out unless you check manually.

Internet Fax reception settings can be changed from TopAccess. 
For details of the operation, refer to the TopAccess Guide.

 Receiving Internet Faxes automatically

The administrator can set up the equipment configuration on TopAccess to automatically receive Internet faxes from 
the E-mail server. If the “Scan Rate” setting is specified, the equipment accesses the E-mail server to check for any 
new E-mail at specified intervals. (The factory default is 5 minutes.) For more details, refer to the TopAccess Guide.

 Receiving Internet Faxes manually

1 Press [User Functions -User-] on the Home screen.

2 On the [User] tab, press [Check E-mail].

 The equipment begins checking for new E-mail. If Internet Faxes have been received, “RECEIVING E-mail” 
appears on the screen. After “NEW E-mail RECEIVED” is displayed, the equipment starts printing the Internet 
Faxes.

 If no new E-mail are found, “CURRENTLY NO E-mail” is displayed on the screen.
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0.TRANSMISSION JOURNAL

*1 This item is not available to some models.

Mode: 1. Communication mode

Item name Description

ROM version Firmware version of the FAX Unit and the MFP. This appears at the upper right of the 
list.

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

NO. Serial number assigned to each communication (001 to 999)

FILE NO. File number for communication

DATE TIME Start date and time for communication

DURATION Communication period (indicated by a “minutes:seconds” form)

PGS Number of pages for communication

TO Communicated destination telephone number or name registered in the address book

If the  mark is indicated, the 2nd fax number registered in the address book has been 
used.

DEPT Department code
(If the department control is not performed, this field will become blank.)

MODE Communication mode (2 digits) and transmission method (3 digits) or special 
communication mode (2 digits)

If the  mark is indicated, the 2nd line has been used.
See the following table for the codes displayed in this field.

STATUS Communication result and error code

 OK: Completed successfully

 NG: Completed abnormally

 4-digit error code: Communication failed

For details about the error codes, refer to the Software Troubleshooting Guide.

Display Communication mode

EC ECM communication

G3 G3 communication

ML Email communication
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Mode: 2. Transmission method

Mode: 3. Special communication mode

Display
Transmission speed 

(bps)
Resolution
(pels/min)

Encoding systems

0 2,400 8 x 3.85 MH

1 4,800 8 x 7.7 MR

2 7,200 8 x 15.4 MMR

3 9,600 JBIG

4 12,000 16 x 15.4

5 14,400

6 V.34

7

8 300 dpi

B 600 dpi

D 150 dpi

C 100 dpi

Display Special communication mode

P Polling communication

SB Mailbox communication

S R, R Relay mailbox communication

SF, F Forward mailbox communication

ML Internet Fax communication

I N/W-fax communication

O Offramp Gateway communication
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0.RECEPTION JOURNAL

*1 This item is not available to some models.

Mode: 1. Communication mode

Item name Description

ROM version Firmware version of the FAX Unit and the MFP. This appears at the upper right of the 
list.

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

NO. Serial number assigned to each communication (001 to 999)

FILE NO. File number for communication

DATE TIME Start date and time for communication

DURATION Communication period (indicated by a “minutes:seconds” form)

PGS Number of pages for communication

FROM Communicated destination telephone number or name registered in the address book

If the  mark is indicated, the 2nd fax number registered in the address book has been 
used.

DEPT Department code
(If the department control is not performed, this field will become blank.)

MODE Communication mode (2 digits) and transmission method (3 digits) or special 
communication mode (2 digits)

If the  mark is indicated, the 2nd line has been used. See the following table for the 
codes displayed in this field.

STATUS Communication result and error code

 OK: Completed successfully

 NG: Completed abnormally

 4-digit error code: Communication failed

For details about the error codes, refer to the Software Troubleshooting Guide.

Display Communication mode

EC ECM communication

G3 G3 communication

ML Email communication
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Mode: 2. Transmission method

Mode: 3. Special communication mode

Display
Transmission speed 

(bps)
Resolution
(pels/min)

Encoding systems

0 2,400 8 x 3.85 MH

1 4,800 8 x 7.7 MR

2 7,200 8 x 15.4 MMR

3 9,600 JBIG

4 12,000 16 x 15.4

5 14,400

6 V.34

7

8 300 dpi

B 600 dpi

D 150 dpi

C 100 dpi

Display Special communication mode

P Polling communication

SB Mailbox communication

S R, R Relay mailbox communication

SF, F Forward mailbox communication

ML Internet Fax communication

I N/W-fax communication

O Offramp Gateway communication
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0.RESERVATION LIST

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

TX / RX Reserved jobs for transmission/reception

RECOVERY TX Reserved jobs which are made by recovery transmission

PC JOB Reserved jobs which are made from a client computer

FILE NO. File number for communication

DATE TIME Start date and time for communication

FUNCTION Type of transmission/reception

PGS Number of pages for communication

TO Communicated destination telephone number or name registered in the address book.
If the  mark is indicated, the recipient has been specified with the direct entry 
method.
If a G mark is indicated, the recipient has been specified with the group entry method.

DELAY TIME Specified time for transmission (if registered)
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0.MAILBOX/RELAY BOX REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

MAIL BOX History of confidential mailbox job and bulletin board mailbox job

RELAY History of relay station mailbox job

FORWARD/INBOUND 
FAX(TSI)

History of forwarded jobs and inbound fax jobs (TSI)

BOX NO. Box number of the communication destination

BOX TYPE Type of communication

PGS Number of pages for communication

FILE NO. File number for communication

DATE TIME Start date and time for communication

FROM Originator of jobs

END STATION ID code of the end station
This field indicates an E-mail address by a 4-digit number and a group ID by a 3-digit 
number.

REPLY TO NUMBER Telephone number of the reply destination

AGENT Type of the agent

DESTINATION Details of the forwarded recipient
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0.MEMORY TRANSMISSION REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

TO Communication destination

If the  mark is indicated, the 2nd fax number registered in the address book has been 
used.
If the  mark is indicated, the recipient has been specified with the direct entry 
method.

DOCUMENT PAGES Number of original pages to be transmitted

START TIME Start date and time for communication

END TIME End date and time for communication

PAGES SENT Number of pages for communication

STATUS Communication result and error code

 OK: Completed successfully

 NG: Completed abnormally

 4-digit error code: Communication failed

For details about the error codes, refer to the Software Troubleshooting Guide.
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0.TRANSMISSION REPORT

*1 This item is not available to some models.

Item name Description

ROM version Firmware version of the FAX Unit and the MFP. This appears at the upper right of the 
list.

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

NO. Serial number assigned to each communication (001 to 999)

FILE NO. File number for communication

DATE TIME Start date and time for communication

DURATION Communication period (indicated by a “minutes:seconds” form)

PGS Number of original pages transmitted

TO Communicated destination telephone number or name registered in the address book.

If the  mark is indicated, the 2nd fax number registered in the address book has been 
used.

DEPT Department code
(If the department control is not performed, this field will become blank.)

MODE Communication mode (2 digits) and transmission method (3 digits) or special 
communication mode (2 digits)

If the  mark is indicated, the 2nd line has been used.
See the following table for the codes displayed in this field.

STATUS Communication result and error code

 OK: Completed successfully

 NG: Completed abnormally

 4-digit error code: Communication failed

For details about the error codes, refer to the Software Troubleshooting Guide.
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0.MULTI TRANSMISSION REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

START TIME Start date and time for communication

END TIME End date and time for communication

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

ADDRESS BOOK Communicated destination name registered in the address book.

If the  mark is indicated, the 2nd fax number registered in the address book has been 
used.

FAX NUMBER Registered name of communicated destination telephone number.
If the  mark is indicated, the recipient has been specified with the direct entry 
method.

PAGES SENT Number of pages for communication
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0.MULTI POLLING REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

START TIME Start date and time for communication

END TIME End date and time for communication

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

ADDRESS BOOK Communicated destination name registered in the address book

FAX NUMBER Registered name of communicated destination telephone number.
If the  mark is indicated, the recipient has been specified with the direct entry 
method.
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0.RELAY TX ORIG. TERMINAL REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

TO Communicated destination telephone number or name registered in the address book.
If the  mark is indicated, the recipient has been specified with the direct entry 
method.

RELAY BOX Box number of the communication destination

DOCUMENT PAGES Number of original pages to be transmitted

START TIME Start date and time for communication

END TIME End date and time for communication

PAGES SENT Number of pages for communication

STATUS Communication result

 OK: Completed successfully

 NG: Completed abnormally
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0.RELAY TX RELAY STATION REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

DOCUMENT PAGES Number of original pages to be transmitted

FROM Telephone number of the originator

START TIME Start date and time for communication

END TIME End date and time for communication

RELAY BOX Box number of the communication destination

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

GROUP NUMBER Group number of the communicated destination

ADDRESS BOOK Communicated destination name registered in the address book

If the  mark is indicated, the 2nd fax number registered in the address book has been 
used.

PAGES SENT Number of pages for communication
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0.RELAY TX END TERMINAL REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

DOCUMENT PAGES Number of original pages to be transmitted

FROM Telephone number of the originator

START TIME Start date and time for communication

END TIME End date and time for communication

RELAY BOX Box number of the communication destination

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

GROUP NUMBER Group number of the communicated destination

ADDRESS BOOK Communicated destination name registered in the address book.

If the  mark is indicated, the 2nd fax number registered in the address book has been 
used.

PAGES SENT Number of pages for communication
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0.RELAY STATION REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

RELAY BOX Box number of the communication destination

DOCUMENT PAGES Number of original pages to be transmitted

FROM Telephone number of the originator
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0.MAILBOX RECEPTION REPORT

*1 This item is not available to some models.

Item name Description

TIME Date and time of the output of the journal

FAX NO.1 Sender’s fax number (line 1)

FAX NO.2*1 Sender’s fax number (line 2)

NAME Registered terminal ID

FILE NO. File number for communication

DATE Reception date and time for communication

BOX NUMBER Box number of the communication destination

BOX TYPE Type of communication

DOCUMENT PAGES Number of original pages to be transmitted

FROM Telephone number of the originator
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0.Specifications of GD-1370

*1 For the internal storage device, MB means 1 million bytes. (Total accessible capacity of the internal storage device may vary depending on 
operating environment.)

Specifications and appearance are subject to change without notice in the interest of product improvement.
If trouble occurs, call service for assistance.

Model Name GD-1370NA/EU

Size of Original
(A/B format)

Other than e-STUDIO400AC Series:
A3, A4, A4-R, A5, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP
e-STUDIO400AC Series:
A4, B5, A5, FOLIO, LG, LT, ST

Recording Paper Size 
(A/B format)

Other than e-STUDIO400AC Series:
A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP
e-STUDIO400AC Series:
A4, B5, A5, FOLIO, LG, LT, ST

Compatibility Communication 
Modes

ECM, Super G3

Communication Resolution Horizontal: 8 dots/mm, 16 dots/mm, 300 dots/inch

Vertical: 3.85 lines/mm, 7.7 lines/mm, 15.4 lines/mm, 300 dots/inch

Transmission Rate 33,600/31,200/28,800/26,400/24,000/21,600/19,200/16,800/14,400/12,000/
9,600/7,200/4,800/2,400 bps

Encoding Systems JBIG/MMR/MR/MH

Memory Capacity Transmission/Reception: 1GB *1

Unit Type Desktop type, transmitting/receiving dual type

Applicable Network Public Switched Telephone Network (PSTN)
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Advanced.......................................................................  101
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B
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Bulletin board mailbox ...................................................  61

C
Canceling reserved transmissions .................................  55
Canceling the memory transmission job.......................  53
Communication status log .............................................  51
Community Name .........................................................  106
Confidential mailbox ......................................................  61
Connecting cables...........................................................  18
Control panel...................................................................  16
Cover Sheet ............................................................ 103, 104

D
Delayed Fax ............................................................ 103, 112
Delete.............................................................................  110
Department Code..........................................................  102
Department management..............................................  17
Details ............................................................................  108
[Device Settings] tab.....................................................  108
Different width originals .................................................  26
Direct Tx...........................................................................  33

E
ECM for G3 .......................................................................  33
Edit.................................................................................  103
E-mail.......................................................................... 75, 76
E-mail address............................................................ 75, 76
Enter the user credentials manually ............................  108
Exposure................................................................... 32, 122
External telephone.........................................  19, 42, 43, 47

F
Fax Function..................................................................  109
Fax Number ...................................................................  102
Features

Internet Fax................................................................  120
File Format ............................................................. 103, 111
File formats ...................................................................  124
Fonts ..............................................................................  104
Footer ............................................................................  105
FTP ...................................................................................  79
FTPS.................................................................................  79

H
Header Text ...................................................................  105
Help................................................................................  103
Hide Department Code .................................................  103

I
initial setting .................................................................  100
Internet Fax ................................................................ 50, 76

precautions ................................................................  121
receiving.....................................................................  124
sending.......................................................................  122

Internet Fax Address .....................................................  102
Internet Fax Function ....................................................  109
ITU-T...........................................................................  33, 61

J
[Job Status] .....................................................................  16

L
[Layout] tab ...................................................................  101
Line Select .......................................................................  33

M
Mailbox Communication.................................................  33
Mailbox Transmission

creating the confidential or 
bulletin board mailbox ................................................  67
creating/modifying a relay station mailbox ...............  69
deleting a mailbox .......................................................  71
deleting originals .........................................................  64
printing originals..........................................................  63
registering originals .....................................................  62
retrieving originals.......................................................  66
sending originals..........................................................  65

Memory Tx .......................................................................  33
Message .........................................................................  105

N
N/W-Fax driver options .................................................  101
NetWareIP ........................................................................  80
NetWareIPX......................................................................  80
Network Fax.....................................................................  50
Next original ....................................................................  29

O
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Off-hook transmission ....................................................  43
Offramp Gateway ............................................................  76
On-hook transmission.....................................................  42
Onramp Gateway ............................................................  75
[Option]............................................................................  34
Options ............................................................................  17
Orientation ....................................................................  101
Original

original scanning range ...............................................  23
originals that can be sent ............................................  22
placing the original(s) on the original glass................  23

Original Mode ..........................................................  32, 122
Original Size.............................................................  30, 122

P
Paper

acceptable size of paper..............................................  44
default setting for Rx printing .....................................  44
paper priority when there is 
no same size paper ......................................................  45

Pausing transmission......................................................  55
[Preview] ..........................................................................  40
Preview ..........................................................................  104
Printing lists & reports

automatically ...............................................................  85
manually.......................................................................  83

Priority Reserve .............................................................  123
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public network line .........................................................  19
PWD..................................................................................  93

Q
Quality Tx.........................................................................  33

R
Receiving

Auto reception .............................................................  47
Manual reception.........................................................  47
Memory reception .......................................................  48

Recipient
Confirming/Deleting the recipients ............................  39
searching for the recipient’s fax number ...................  36
specifying the recipient in the address book .............  36

Recipient’s Information ................................................  105
Redial function ................................................................  28
Reference Number ........................................................  105
Relay station mailbox .....................................................  61
Remove..........................................................................  102
Removing recipients .......................................................  99
Reserved transmissions..................................................  50
Resolution ........................................................  31, 102, 122
Restore Defaults.............................................  103, 105, 107
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[Send] tab ......................................................................  102
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Server Name........................................................... 103, 110
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SMTP server.....................................................................  76
SNMP Settings ........................................................ 103, 106
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Subject...........................................................................  105
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Touch panel.....................................................................  16
Transmission conditions

changing the settings for each page...........................  34
Tx Type ..................................................................... 33, 122

U
Update Automatically...................................................  108
Update Now...................................................................  110
User Authentication ......................................................  108
User management ..........................................................  17

V
Version

N/W-Fax driver ...........................................................  109
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